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1  Getting Started

1.1  What is MindCAD?
MindCAD is a suite of specialist programs that have been developed specifically for shoe design and
manufacturing.

Last Design & Engineering - For input, modification and flattening of lasts.

3D Design & Engineering - Allows lines to be drawn on a last in 3D and 2D. These lines can then
be used to create parts with thickness, and textures. Accessories, punches, holes and padding can
also be added, as well as laces and soles.

The final design can be output to:

2D Design & Engineering - For 2D part creation, grading, cutting and specification

Viewer - This is a free package of visualization software from Mind and can be downloaded from
Mind Technology website.

1.2  Before you begin
IMPORTANTE NOTE: A valid product authorization file must be installed before MindCAD can be
used.

If you’d like some sample data to use inMindCAD 2D Design & Engineering :

1. From the File menu, select Open to load example projects.

2. Select a file and press “Open” (or double click the file).
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All instructions in this manual are correct at the time of printing. Some sections may not be up to
date due to subsequent updates to MindCAD 2D Design & Engineering.

1.3  How do I start MindCAD 2D Design & Engineering?

Double click the MindCAD 2D Design & Engineering's icon  on your desktop. MindCAD
2D Design & Engineering will start shortly after.

1.4  How do I use the menus?

Almost everything inMindCAD 2D Design & Engineering  can be accessed  through the main
menu. This is shown in the picture above and is displayed at the top of the MindCAD 2D Design &
Engineering   screen.

1. Select an item from the main menu. A drop down list is displayed, showing a list of sub-items,
each corresponding to specific program action. Greyed out sub-items mean that a specific
program action is not available (e.g. a paste action will not be available is no copy action was
previously executed).

2. If you move your mouse to an item that has an arrow alongside, as highlighted above, an
additional list of sub-items will appear.
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3. If the item is followed by just … (for example, Save as… below), selecting the item will display a
dialog box so that you can enter data and make selections.
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1.5  MindCAD2D Design & Engineering Layout
The image below show the MindCAD 2D Design & Engineering interface.

1. Menu Bar - Most of MindCAD 2D Design & Engineering’s functionality may be accessed
through this menu.

2. Main Bar - This toolbar allows a user to open a new project or an existing one, save a project,
print, cut, copy, paste, undo, redo, zoom to fit, go to help topics and open Mind's web site.

3. Constrain Bar - This toolbar have the options to let you 'snap' editing or drawing operations to
specific points.

4. Grading Bar - This toolbar allows a user to open all the grading options.

5. Layers Bar - This toolbar have the options to let you turn on/off the layers of the project.

6. Tools Bar - This toolbar allows a user to select the draw lines tool, on/off the links, create offsets,
mirror selected lines, cut lines and copy objects properties.

7. Change sweet - In Mind 2D Design & Engineering it's possible to have more that one sweet
open

8. Tool Options - This window shows the options available for the tool that are selected in the
moment, i.e., if you select the option draw lines the tool option will show the type off lines
available but if you select for example the tool create parts the tool option will show the treatments
that are available among other things.

9. Object Browser Bar - This toolbar shows the elements' hierarchy, through this toolbar it's
possible to freeze/unfreeze and show/hid elements, layers among other things.  

10.Draw area - Is in this area that the 2D part creation, grading and specification are made and
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seen.

11.Parts Bar - This toolbar have the options to let you create parts, holes, add lines and remove
lines.

12.Parts/Library Bar - This toolbar have two tabs, the Parts where you can see the created parts,
access their proprieties among other things and the Punches tab where you can see the existing
punches, you can remove or add punches from the toolbar. 

13.Change Page - In MindCAD 2D Design & Engineering it's possible to have more that one
page, its possible to Create, Duplicate, Import and Delete.

1.6  How do I manipulate the view contents?
There are two main interaction classes for direct manipulation of the 2D environment:

Scaling

Moving (Panning)

1.6.1  Scaling
To scale the view, in both 3D and 2D windows,

1. Press the Ctrl key and hold down the middle mouse button. View contents will scale up/down as
the mouse is moved up/down.

2. Releasing the middle mouse button will end the scaling process.

If you have a wheel mouse, you can also use the wheel to change the scale.

1.6.2  Mov ing (Panning)
To move the view contents, in 2D windows,

1. Hold down the middle mouse button. As the cursor is moved, view contents will move with it.

2. Releasing the middle button will end the process.

1.7  Getting Help with MindCAD 2D Design & Engineering

Help in  MindCAD 2D Design & Engineering is available in the following ways:

Tool Tips

Status Bar Help

Standard online Help
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1.7.1  Tool tips
Placing the cursor over a button will display a brief description of the function of the button.

1.7.2  Status Bar Help
Placing the cursor over a button will display information about the button in the status bar.

1.7.3  Standard online Help
1. Select Help from the MindCAD 2D Design & Engineering toolbar.

2. Select Contents and Index and then the item you require. There is a separate section in the help
for each option on the main toolbar.

1.7.4  Interaction with MindCAD 3D Design & Engineering
You can make MindCAD 2D Design & Engineering interact with MindCAD 3D Design &
Engineering. This will happen if both programs are open and working on models that have the same
source. This would normally be a file that is exported from MindCAD 3D Design & Engineering to
MindCAD 2D Design & Engineering, but it can be the reverse.

Any edits done in either program will update the other program.

Ensure that the lines in both programs have the correct Export to options set. If you do not want
lines to update, make sure that they are not exported.

If only one program is open and you wish to update the corresponding data in the other program,
you must export the BGD file and import it to the other program.

1.8  What's New!

1.8.1  2008
Lots of enhancements and new features were added to 2D Design & Engineering. The following list
explains briefly what is changed and provides direct linkage to the manual section where you can get
further information.

Import Pictures
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Option to import picture in several formats (jpg, bmp, gif, tif, png...) . For details please check File
- Import - Image.

Alignment Points

Option to align the reference points of the current shell and the physical reference points on the
digitizer. For details please check Edit - Alignment Points.

Line Editing

Offset Original Line

Option to make change to original line instead of creating a new one. For details please check
Creating and offset to a line.

Virtual Mirror

It is possible to do a mirror of selected geometry without having to select an axis. For details please
check Tools - Drawing - Line.

Grading 

Faster interaction

Faster grading by automatically creating a primary axis. For details please check Grading - Basic
Steps for Grading.

Grading types

Option to create grading types.  For details please check Adding a Grading Type.

Easier interaction for Parallel Restriction

Easier operation for Parallel Restriction option. For details please check Grading - Apply Parallel
Restriction.

Ask for base size when creating model 

Option for when creating a new model, asking for the base size. For details please check File -
Preferences - Grading.

Printing

New options to control printing of the shell. For details please check File - Page Setup.

Parts

Simulate Cut

A new interface to simulate part cutting paths. For details please check Simulate Cut.

Invert code

The operator can define the code position which has the option of being inverted (outside or inside). 
For details please check Editing Parts - Points.

Markers
Parameter for side indicator size. For details please check Operations - Markers.

Punches
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More Parameters

More punch parameters are available like Number of lines and Rotation. For details please check
Operations - Punches.

Grading behaviour

New options to control punch behaviour while grading. For details please check Punches Grading
Behaviour. 

Parts Bar

Filter and sort

New functionality to filter parts by material, sorting parts by alphabetic order and hiding empty part
thumbnails. For details please check Editing Parts - Parts Bar.

Quick Properties

When we hover the cursor on the part, a quick properties window appears. For details please check
Editing Parts - Parts Bar.

1.8.2  2009.JUL
Lots of enhancements and new features were added to 2D Design & Engineering for this update.
The following list explains briefly what is changed and provides direct linkage to the manual section
where you can get further information.

Popup menus

Options to customize popup menus. Please refer to Popup Menus.

Enhanced editing

Rectangles

Extra control point added to rectangle primitive. For details please check Tools - Drawing -
Rectangle.

Faster springing

Modification to the rotation tool enables for faster operations like springing. The new Space to rotate
option is used to determine which points of the selected lines will be affected. Please refer to Tools -
Change - Rotate for details.

Wrapping lines

A new scale length factor (% / mm) could be used to extend or decrease the wrapped lines lengths.
Please refer to Tools - Change - Wrap Lines for details

Multiple part picking

Now it is possible to control picking of multiple parts. For details please check File - Preferences -
Options.

New Shapes

Symmetric Shapes

Support for intrinsic symmetric shapes. Circles, Ellipse and regular shapes are included in this set.
Please refer to Symmetric Shapes for details.
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Sawtooth Lines

Support for sawtooth lines. Please refer to Tools - Drawing - Sawtooth for details.

Parts

Creating an unfolded mirrored part (2 axis)

Create parts with 2 axis. Please refer to Creating unfolded mirrored part (2 axis) for details.

Support for multiply folded parts

This new tool allows adding extra material for folded parts.

Notches

Faster creation of notches using an accelerator (SHIFT key). Please refer to Editing Parts - Notches
for details.

Corners

Added parameters for radius on square corners. Please refer to Editing Parts - Corners for details.

Treatments 

Dedicated Stretch tabulator for supporting new part stretching capabilities. Please refer to Editing
Parts - Stretch for details.

Part Assessment and Costing

Integrated part assessment for fast efficiency tuning. For details please check Parts - Costing and
Editing Parts - Costing.

1.8.3  2009.SEP
Lots of enhancements and new features were added to 2D Design & Engineering for this update.
The following list explains briefly what is changed and provides direct linkage to the manual section
where you can get further information.

Tools

Wrapping tool

New absolute offset parameter for the wrapping tool. For details please check Tools - Change - Wrap
Lines.

Parts

Part collection

Enhanced part collection algorithm handling collinear lines properly.

Cutting

Faster generation of cutting model file.
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1.8.4  2010.V1
Lots of enhancements and new features were added to 2D Design & Engineering for this update.
The following list explains briefly what is changed and provides direct linkage to the manual section
where you can get further information.

Generic
Works on Windows7 (x86, x64)

Memory leaks fixed due to shell protection

Notes window with autopen option.

Grading table values lock option.

Multiple speed and stability bug.

Editing

Multiple offset lines in a single operation

Sawtooth parameters in tool parameters box

Switch side interface now applied to offsets, markers and punches.

Multiple punch lines tool.

Snap to geometric center on symmetry tool.

Retrieval of last tool used.

Several new accelerators for Scale and Move tools.

Parts
Bug fixing on label positioning over parts.

Part window pre-selection for part collection

Oblique line notches on treatments

Ability to force smooth corners on treatments. 

Export/Import
Import from 2D Design & Engineering file with multiple pages and improved selection.

1.8.5  2011.V1
Lots of enhancements and new features were added to 2D Design & Engineering for this update.
The following list explains briefly what is changed and provides direct linkage to the manual section
where you can get further information.

Part Design 

Parts 

Single click support for part collection tool and holes tool. 

Enhanced part collection tool with information about last collected parts. 

Markers 

New markers trimming options. 
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Cuts 

New tool for placing cuts in parts created with multiple axes. 

Notches 

Enhanced notches tools allowing individual control and distribution dependencies amongst other
features. 

Part points 

Automatic placement of special part points when changing part geometry. 

Part labels 

Revised interface for custom part labels. 

Line Design 

Sawtooth lines 

Sawtooth lines in sections. 

New tool to shorten lines 

Option Extend/Shorten Line, to short the line simply enters a negative value 

Editing Accelerators 

Layers 

Reposition of Image layer to the bottom most. 

Constrains 

Enhanced constrains on orthogonal restriction. 

Keyboard editing 

It’s now possible to add a step value for line movement control: when the keyboard arrows are
pressed, the line will be moved by the predefined value. This option is available by doing a right
click over a selected line. 

Text drawing over line 

It’s now easier to place the text in the right position: moving the line the text will follow. 

Distance dependency tool 

A new tool to control line position based on extracted length property from other elements. 

Selection 

Automatic element selection after creation. 

Multiple handle selection on lines. 

Design Accelerators 

Massive reuse of developed patterns 

Import of selected sheet/geometry from other projects. 

Digitize from images 

It's now possible to digitize from images; this option is available in the option Digitize form File
menu. 

User Interface Enhancements 
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Grading table 

General revision of grading table: When the values from the Detailed grading table are changed
by the user, the Main grading table will change to yellow, as a warning. 

Show/Hide images and notches 

This option is available in View – Layers. 

Zoom to fit to selected elements 

Just select the desired element and click Zoom to fit. 

Keyboard shortcuts 

New keyboard shortcut for Join Lines, CTRL+J. 

Interoperability 

Revised import infrastructure 

Possibility for manage importers: new Manage Importers option in File > Import menu. You can
now include new predefined importers, such as MDB, IbertecXMaker SPF, DimensionsPro and
DXF(Teseo). 

Revised DXF import 

Enhanced DXF import, now including corner smoothing. 

Revised options for importing from images 

General revision of options and processes while importing from images. It is now possible to
vectorize directly from images and have a better control of DPI (resolution in dots per inch) for
imported materials. 

Costing 

Costing for knifes 

General revision on interface and new options: new report’s format, PDF and CSV. 

It´s also possible to add costing options, like Currency, Area cost, Margin, etc. 

Cut Engineering 

Punch groups 

Property inheritance for punch groups while exporting for cutting. 

New cutting machines available 

It’s possible to access them in the option Manage Cutters. 

1.8.6  2013.V1
MindCAD 2D Design & Engineering® software offers the following new features and benefits:

User Interface Enhancements

Revised icons dimensions

By default, the icons are now smaller.

If you prefer the larger icons, you can enable them on Customize > Options.
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Interface customization

New options for advanced interface customization (menus, toolbars, buttons, etc.)

More options and shortcuts

More options and shortcut keys available at the contextual menu of some tools (markers,
e.g.).

Toolbox Line Thickness

New line width selection, available from the toolbox.

Line Coloring

New line coloring modes: by layer, properties, normal or dependencies. 

Image transparency

Support for transparency for imported images enabling stencil type usage when doing
referenced modelling.

Windows resize 

You can now resize the Export and Open File panels, thus improving the interaction with the
file system.

Editing Accelerators

File locking

A file locking mechanism prevents multiple users open simultaneously the same file.

Average lines tool

Quick modification of two lines to establish a mean plus blend region effect.

Punches insertion fix

Fixed the automatic assignment of side on the insertion of intersecting punches.

Export validation

Notification of potential errors during the export of parts for cutting, namely “Tabs with non-
graded parts”, “Sizes do not match”, “Equal parts name between tabs”.

Part Design Accelerators

Point assignment interface 

New interfaces for assignment of entry points, code points and orientation points. Includes
assignment of entry points into holes.

Coding system using marks

New industry standard coding system using marks. This is needed when classic notch
coding approach is not suitable due to production requirements.

Improved tool for boundary line’s insertion

New median tool

It is now possible to generate multiple bisection lines with distinct distances from parent
lines.

Part boundary replacement

It is now possible to replace completely a part boundary.

Sawtooth on section with margins
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Initial and final margins for saw-toothed sections. Negative margins for sectioned markers.

Sub-grading base number

Alias definition for the base number of a sub-grading.

Boundary lines into plan

Drag boundary lines from several parts into plan.

Destroyed parts notification

Notification of destroyed parts during the line edition process (with possible rollback).

Parts Variants

Variants of parts by size (for manual scaling).

Offset distance value preview

You can watch the offset distance change while you move the offset point.

Offset by size group

You can now define different offset values for different size groups.

You can also apply the distance dependent operation to those size groups.

Saving default settings

Save the default settings for markers, parallels, etc. 

Scaling of rectangles

Problems on rectangle scaling are now fixed.

Corner and notches selection

New option for selecting all corners or notches of the entire piece, to change simultaneously
their parameters.

Bounding box fix

Fixed incorrect scaling bounding box for partially hidden lines.

Hole removal

Automatic removal of holes placed outside the part.

Markers on parts with more than 2-axes

You can now add markers and punches on parts with more than 2-axes (as it was already
possible with lines and cuts).

Snapping on Cut Line tool

The Cut line tool is now sensitive to snapping rules.

Notches in treatments

You have now offset automatic notches in treatments

Sub grading assigned to an axis

You can now assign sub grading to an axis.

1.8.7  2015.V1
MindCAD 2D Design & Engineering® 2015.V1 release offers the following new features and fixes:

Design Accelerators

New springing tool



29Getting Started

© 2016 M ind - Software Multimedia e Indus tr ial , SA

Semi-automatic springing process allowing for a coordinated rotation and offsetting of parts.
Full undo/redo functionality provides valuable guidance in this complex process.

New grid tool for parts

Enhanced grid tool for quick setup of grid distributions of markers and punches over parts.

Enhanced stitch line tool

Optional automatic insertion of corners while stitching multiple lines to ensure smooth
transitions.

Enhanced wrinkles tool

Now it includes not only the previous deformation concept but also torsion areas. Optional
insertion of markers and lines is added for production reference. Also for visual consistency,
previously added stencils through treatments will also be twisted following added deformation specific
to this tool.

Enhanced trim tool

New approach on trim tool interface. This will allow for a wider range of line trimming
scenarios.

Enhanced punches tool

Enabled symmetry in punches distribution. This provides consistency against the previous
process which was difficult to understand and heavily based on parameter tweaking.

Enhanced cut assignment tool

Revision of this tool for better handling of mirrored parts.

History of geometric modification of parts

Visual history tracking of line previous geometry.

Usability and Productivity

New search engine for parts 

Included in MindGEST PDM for Modelling. It is now possible to search for similar parts from
a specific project. Results are ordered by matching confidence level. Parts are imported to current
project on- demand.

Enhancements in parts labeling

Improved creation and automatic positioning of multiple labels to a part. Since there is also a
template support approach, it is easy to quickly configure automatic assignment of each factory
standard labels.

Enhanced copy of elements between parts

Improved copying process of any element from a part to another. This will massively reduce
development time for parts that share many internal features.

Revised Material and Cost Groups concept

Previous configured Material and Cut Groups are automatically merged into the single group
concept. This group concept is now the basis for automatically setting up Variants and Options of
the model. Like before, group assignment can be modified at Part Properties.

Support for positioning of parts on materials

In order to support automatic and manual positioning of parts on materials in MindCUT
product family, creation and editing of alignment points for parts is introduced.

Interoperability
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New generic exporter

New generic multi-format exporter, script-based.

Enhanced support for several exporters 

Including DXF, CNC, HPGL, Graftec and JingWei formats.

Enhanced support for parts and shells import

Better import for external file formats like IBA/VET. Tuning of the automatic filtering of high
point density lines. 

Additional file save or export validation

Warning about saving over an existing file and about exporting parts with the same name.

1.8.8  2016.V1
MindCAD 2D Design & Engineering ® 2016 release offers the following new features and
enhancements:

MODELLING FEATURES

Modelling Accelerators

Filling closed shapes

Support color selection and filling of closed shapes, like circles and rectangles.

New punch block tool

New parametric punch block tool, including size and property settings.

The punches can now be created by parameters – e.g. size, distance to the center, angle. The
punches thus defined can be stored in a file for later use.

New sawtooth definition method

Variable wavelength parameter for sawtooth.

Spring adjustments

Footwear specific. Spring adjustment tool enhancements: semi-automatic adjustments; precise
move control.

Reference points

Automatic creation of reference points.

Rotation angles parameters

Setup default values for base angle and angle restrictions - Rotation angles.

Stencil margins

Setup default stencil trim margin - Default stencils margin.

Quick selection of dependent parts 

Select and display dependent parts, directly from Line Properties, Dependencies Tab.

New Change tools

 Break Line by Angle and Join Lines by Distance.

Usability and Productivity
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Text alignment

New text alignment options: left or right.

Font style preview

Preview of selected font style for text parametrization.

Interior stencil line separation

On Manage Cutters – Properties – Model 1 you can define interior stencil line separation. Applies
only to laser cutters.

Label placement on parts

Automatic label placement on part allowance border.

Show/ hide image layer 

Added visibility control of image layer.

Parts information

On Parts/ Library, you can now add a part orientation arrow.

You can now add a Dimension label into the part text.

Interoperability

Easier model save into PDM

Fill helper while saving model into PDM

New export interface for cutting parts

Resized selection table. Selection highlight displayed on the model export window. Select from first
to last part, using the SHIFT key.

Enhanced Importers management interface 

Importers/Controllers management interface redesigned for coherence and usability.

Support for multiple machine export

Send a model for more than a cut machine, simultaneously. 

 

GRADING FEATURES

Usability and Productivity

Revised interface for grading table

Larger grading table, displaying all grading sizes.

New variants from graded sizes

You can now modify part geometry for each graded size.





Part

II



34 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

2  File Overview
This menu lets you create new files, open existing files, close and save files. It also lets you import
and export data, set your preferences, print and cut files.

Use this option to open a recently used project. The names of the last five files are displayed at the
bottom of the menu for quick selection.

2.1  File - New
Use this option to create a new file.

This is the same as clicking the Create new file button  in the Main toolbar or pressing Ctrl+N

A dialog appears for configuration of grading type and base size (those values are populate from
parameters available on preferences).
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2.2  File - Open
Use this option to open any of your files.

This is the same as clicking the Open File  button in the Main toolbar or pressing Ctrl+O

Use this option to open any of your projects from a central database.

Insert the server, user and password and press Ok.

The follow window will appear.
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To open a file from pdm, select the desired one and select Open.
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To open a stand alone file, select the Open from file button and select the file to open.
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Note: If the project is opened by other user, it will open in ready only mode. 

2.2.1  Re-open
This is one of the options that can be added to the customised toolbar.

 Re-open File - Use this option to re-open the current shell. The shell will be opened as it
was when last saved.
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2.3  File - Close
Use this option to close the current file.

This is the same as clicking the X button in the corner of any window.

2.4  File - Save
Use this option to save the current file with the current name.

This is the same as clicking the Save  button in the Main toolbar or pressing Ctrl+S

Use this option to save the current project with the current name to a central database.

2.5  File - Save As
This option allows you to save the current project in a different store and with a different name.

Enable the publish option to export the created parts to the PDM. 
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2.6  File - Export
Use these options to export the current file to other software packages.

2.6.1  File - Export - MindCAD 2D Design & Engineering (B2D)
Use this option to export the current project in B2D format.

2.6.2  File - Export - ShoeCAD (SCD)
Use this option to export the current project in SCD format.

2.6.3  File - Export - ShoeCAD (DRW)
Use this option to export the current project in DRW format.

2.6.4  File - Export - Image
This option allows to export the current project as an image. It's possible to configure the image
resolution and quality. 

The image can be output in the following formats:

PNG

JPG

BMP
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After selecting the image name and location, the Export image window will appear:

Select the image resolution and quality. 

Check if a checker background is required.

And insert the lines width for the lines that are being exported to the image.  

2.6.5  File - Export - BGD
Use this option to export the current project to 3D Design & Engineering.

2.6.6  File - Export - DGT
Use this option to export the current project in DGT format.

2.6.7  File - Export - DXF
Use this option to export the current project in DXF format.

2.6.8  File - Export - HPGL
Use this option to export the current project in HPGL format.

2.6.9  File - Export - IGES
Use this option to export the current project in IGES format.
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2.6.10  File - Export - Image
This option allows to export the current project as an simplified image. 

The image can be output in the following formats:

2.6.11  File - Export - PDF
Use this option to export the current project in PDF format.

2.6.12  File - Export - Printer
Use this option to export the current project to Printer.

2.7  File - Import
Use these options to import data from other software packages.
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After selecting the file to import, the imported geometry will appear attached to the cursor allowing
the operator to choose the appropriate position. When done, just do a left click and the content will
be pasted.

2.7.1  File - Import - MindCAD 2D Design & Engineering document
This option lets you import data in 2D Design & Engineering document format with multiple
pages.

1.  Select 2D Design & Engineering document form the Import options on File menu. 

2. Select the file to be imported and press Open.

3. Select the components you which to import.
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4. If the imported document has multiple pages and .

2.7.2  File - Import - BGD
Use this option to import data from 3D Design & Engineering.

2.7.3  File - Import - CNC
Use this option to import data in CNC format.
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2.7.4  File - Import - DGT
Use this option to import data in DGT format.

2.7.5  File - Import - DXF
Use this option to import data in DXF format.

2.7.6  File - Import - HPGL
Use this option to import data in HPGL format.

2.7.7  File - Import - IBA/VET
Use this option to import data in IBA/VET format.

2.7.8  File - Import - Image
Use this option to import images.The image can be input in the following formats:

Note: The image layer will be repositioned to the bottom most, to allow a better parts view.

1. Select Image from the Import options of the File menu.

2. Select the image to import and click Open.
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3. Insert the DPI value.

4. The imported image will appear attached to the cursor allowing the operator to choose the
appropriate position. When done, just do a left click and the content will be pasted.

This image could then be used as a tracing image for manual digitizing of lines and parts.

2.7.9  File - Import - ISO
Use this option to import data in ISO format.
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2.7.10  File - Import - MDB
Use this option to import data in MDB format.

2.7.11  File - Import - PDF
Use this option to import data in PDF format.

2.7.12  File - Import - Manage Importers
1. Select Manage Importers from the Import options of the File menu.

2. We could now either select the button New or Import.
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3. Select New, and then the required import type from the menu.

4. That option will now be available in the import menu.
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2.8  File - Cut
This option allows to export parts for cut and to manage the cutters.  
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2.8.1  File - Cut - Cut
This is the same as pressing F8.

1. Use these buttons  to change the visualization format.

a. Choose between Icons View , Tiles View  or Details View 

2. Select/deselect the required parts and sizes by clicking in the check boxes.  To select/deselect
all option, do a right click over it, to access the options from the contextual menu.

3. Do a right click to access the contextual menu: 
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Override Selection - Allows to change the selected sizes for the selected part. 

The Override Size Selected Part window will open, select/deselect the desired sizes
and press Ok confirm. 

Note: When the override selection is used in a part, the part info will change for red. 

Clear Override - Delete the override changes.  

Copy Override - Copy the override changes. 

Paste Override - Paste the override changes, previous copied. 

Select All - Select all parts.

Deselect All - Deselect all parts.

4. Press Ok when finished, now its possible to select the exporter.
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5. It's possible to select several exporters at once. Do a left click over the required exporters.
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6. Press OK and will be asked to save each one of the exported file formats separately. 

2.8.2  File - Cut - Manage Cutters

Use this option to create a cutter manager for your cutting table

1. From the Cut option of the File menu, select Manage Cutters

A dialogue box is displayed. At this stage the list of options is empty.

2. You to buttons available New or Import. As we are showing the full process, we select New. In
other scenarios, the user can import the predefined settings of an exporter previously saved to a
mcf file. This option is useful to share exporter definitions within or between organizations.

3. Select the required cutter from the menu.



54 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

The exporter you have chosen is displayed in the dialogue box.
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4. Click OK

The next time the Cut menu is selected the exporter you selected will be displayed as an option on
the menu.

2.8.2.1   File - Cut - Properties
Use this option to adjust the setup cutters. 

Select the exporter and press the button Properties. 

A short reference about the available options:

Clone - Creates a copy of the selected exporter.

Export... - Save the parameters of this exporter to a file in mcd format.
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Delete - Delete the selected exporter.

Rename - Rename the selected exporter.

Properties - Inspect and change parameters of the selected exporter.

Select Properties and a configuration dialog appears:

Several properties under the tabs could be adjusted to control the cutting.
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Model(1)

Model(2)

Cutting Area

ZUND

Destination 

Please refer to the corresponding sections for details on those tabs.

2.8.2.1.1  File - Cut - Using Property Rules

On some parameters tabs, a Property Rules  button allows the creation of rules that override

the default configuration. 

For example, if you have stencils using the Knife tool by default but you want, for some of the lines,

to use the Pen tool, you need to create a rule.  Activate Property Rules  button; a dialog

appears.

Press + to add or - to remove rules. Press +. A dialog appears.
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Now we create a rule with targeting a  property named pen. 

This property should previously exist and be used on some lines of the model to be visible. 
Properties are managed using File - Preferences - Default Properties menu option and the user
should apply the properties to the lines.

All the options should be selected as needed to change the behaviour.

In this sample setup, sending stencils with the property pen will use the pen tool instead of the

default knife.
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2.8.2.1.2  File - Cut - Model(1)

Use this Model(1) tab to adjust the first subset of Model parameters

Stencils

- Apply model width - Enable or disable usage of model width for stencils. If unchecked, the width
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of the stencil is defined on the stencil Width (mm) field  

- Rounded - Enable or disable rounded stencils.

- Complete Stencil - Enable or disable complete stencils. If checked all the sections of a stencil will

be connected resulting in a single one.

- Draw twice - Enable or disable draw twice. If checked, a double pass with the tool will be done.

Typically used for hard to draw materials.

- Apply tool compensation - Enable or disable tool compensation.

- Tool - Select default tool.

 

Text

- Activate - Enable or disable text.

- Tool - Select default tool.

- On all sizes - Enable text on all sizes.

- Only one smaller size - Enable text only one smaller size.

- Only one larger size - Enable text only one larger size.

Punches

- Use model geometry - Enable model geometry.

- Convert to circle - Enable convert to circle

- Radius - define circle radius

- Passes - define passes number

- Convert to point - Enable convert to point

- Tool - Select default tool.
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In case the exporter is for a Laser machine, an option to control if the Stencils are printed or not is

also available.  
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2.8.2.1.3  File - Cut - Model(2)

Use this Model(2) tab to adjust the second subset of Model parameters

Lines (inside parts)

- Tool - Select default tool.

Borders (perimeter of parts)

- Tool - Select default tool.
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- Ignore size code geometry - Enable or disable size code geometry.

Notches

- Cut with the border - Enable cut with border.

- Don't cut - If checked notches will not be cut.

- Use specified tool - Enable specified tool

Holes (inside parts)

- Tool - select default tool.

Line filtering

- Activate - enable or disable line filtering. Control the number of points on the filtered lines using

the Amount field.

Corner filtering

- Activate - enable or disable corner filtering. Control the curvature using the Curvature field, the

angle using the Max Angle field and the smoothness using the Smooth factor. 

Other 

- Cardboard - Enable or disable cardboard cutting mode. Group grading is applied to parts.
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2.8.2.1.4  File - Cut - Cutting Area

Use this is the option to adjust the cutting area.

Machine Configuration:

- Dimensions

Width (X) - Machine working area width (in mm);

Length (Y) -  Machine work area length (in mm);

- Cutting Area

Width (X)- Width of the cutting area (in mm);

Offset (Y)  - Offset of the cutting area, relative to the defined origin (in mm);

 - Nesting Area

Width (X)- Width of the nesting area (in mm);

Offset (Y) - Offset of the nesting area, relative to the defined origin (in mm);
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- Pickup Area

Width (X)- Width of the pickup area (in mm);

Offset (Y) - Offset of the pickup area, relative to the defined origin (in mm);

- Cutting offset X - Apply an horizontal (X) offset to the cutting plane (in mm);

- Cutting offset Y - Apply an vertical (Y) offset to the cutting plane (in mm);

2.8.2.1.5  File - Cut - Zund \ Other Cutters

Use this is the option to adjust the setup for the specific machine. This tab is different for each

machine type, in this case we are displaying it for a Zund machine. Proper setup of the parameters

on this tab is only needed  if the machine is connected to the local computer.

Zund

For a Zund machine, the available parameters are: 
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General

 - Wait before start cutting - Select the value in seconds. 

 - Plotter curve Quality - Select the plotter quality, take in consideration that a lower velocity gives
a better quality.

 - On End Cut - Select the tool and if available the up position and down position in mm.

 - General delay instruction - Enable/disable the delay before cut instruction.

 - General tool waiting times default value - Enable/disable the waiting times before and after the
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tool moves. 

Vaccum

 - Vacuum Off to move cells - Turn off the pump to mode the cells configuration.

 - Use Vacuum Curtain - Active this option for machines with vacuum curtain. 

 - Turn off Cells along cut - Check this option to close vacuum cells outside cutting area to improve

material hold.

 - Turn On Vacuum Before Start Cutting - Turn on the pump before start cutting.

 - Turn Off Vacuum After End Cutting - Turn off the vacuum after end cutting. Define the time in

milliseconds.

 - Turn Off Vacuum when idling more than - Turn off the vacuum when the machine is park more

than, define the value in seconds.

 - Enable G3 vacuum support - Enable this option when using the vacuum system specific of a G3

machine.

Conveyor

 - Has Conveyor - Check this box if the machine has a conveyor and you intend to use it.

Milling

 - Mill Radius - Define the radius of the mill (in mm).

Tool Assignment - Select the tool for each slot.

Machine Park - Select from Top Left, Top Right, Bottom Left or Bottom Right.

- Auto Park - Enable or disable the machine Auto Park.

Part Sorting Order - This parameter allows the operator to choose the sequence the parts will be

cut on the table.

 - Half parts first - Checking this option allows that parts divided by a conveyor advance – parts that

don't fit on the cutting window – to be cut first.

Sequencial 

 - Sequencial Cut - Check this option to active the sequential cut order mode. Select the number of

parts to be cut in each group and the tool order.

 - Group - The parts will be cutted in groups of X parts. 

 - Dynamic tool switching - Checking this option, makes the machine stop to allow a tool change.

Tool Order - Tooling order defines the order of operation of each tool during the cutting job.

Click on the Up and Dn buttons to change the order. To enable this option check Sequencial Cut
option.
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Comelz

On a Comelz machine, the available parameters are:

Punch - Radius of the punch tool.

Micro Punch - Radius of the micro punch tool.

Cutter Jet

For a cutter jet machine, the available parameters are: 

Assign Qualities to Materials - Allow to setup different qualities for template materials.

Use floats - Disable - The exported coordinates can only be integers.

    - Enable - Allow the use of non-integer values.
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PDF

For the PDF exporter, the available parameters are: 

Virtual sheet dimensions:

- Length (mm) - Enter the virtual sheet length in mm.

- Width (mm) - Enter the virtual sheet width in mm.

Real sheet dimensions:

- Length (mm) - Enter the real sheet length in mm.

- Width (mm) - Enter the real sheet width in mm.

Draw alignment circles:  Enable or disable draw alignment circles.

- Radius - Enter the circles radius.

- Thickness - Enter the circles thickness.

Draw alignment lines:  Enable or disable draw alignment lines.

- Thickness -  Enter the alignment lines thickness.

Page Overlap (mm) - Enter the page overlap in mm.

Default Line Thickness (mm) - Enter the default line thickness in mm. 
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Printer

For the Printer exporter, the available parameters are: 

Virtual sheet dimensions:

- Length (mm) - Enter the virtual sheet length in mm.

- Width (mm) - Enter the virtual sheet width in mm.

Draw alignment circles:  Enable or disable draw alignment circles.

- Radius - Enter the circles radius.

- Thickness - Enter the circles thickness.

Draw alignment lines:  Enable or disable draw alignment lines.

- Thickness -  Enter the alignment lines thickness.

Page Overlap (mm) - Enter the page overlap in mm.

Default Line Thickness (mm) - Enter the default line thickness in mm. 

HPGL

For the HPGL exporter, the available parameters are: 
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Tool assignment:

- Speed - Enter the tools speed (pen1, pen2,...).

Machine Park: Select from Top Left, Top Right, Bottom Left or Bottom Right.

- Auto Park - Enable or disable the machine Auto Park.

Units - Enter the units.

Pen down command -  Insert the HPGL command or sequence of HPGL commands used to lower

the tool.

Pen up command - Insert the HPGL command or sequence of HPGL commands used to raise the

tool

Pre-cut custom HPGL - HPGL instructions to be sent to the machine before parts.

Post-cut custom HPGL-  HPGL instructions to be sent to the machine after parts.

Graphtec
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For the graphtec exporter, the available parameters are: 

Cut/Draw separately - Enable or disable cut/draw separately .

Send HPGL escape command - Enable or disable send HPGL escape command.

Machine Park: Select from Top Left, Top Right, Bottom Left or Bottom Right.

- Auto Park - Enable or disable the machine Auto Park.
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2.8.2.1.6  File - Cut - Destination

Use this is the option to adjust the destination of the generated data for cutting/plotting.

To File:

- Always use the same file/directory - Enable or disable always use the same file/

directory.

To Comm Port:

- COMM - Enter the comm.

- Parity - Enter the parity.

- Data Bits - Enter the data bits.

- Baud - Enter the baud.

- Stop Bits - Enter the stop bits.

- Flow Control - Enter the flow control.

To LPT Port: Enter the LPT port.



74 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

To Printer Port: Enter the printer port.

To Remote Service: 

- Server - URL of the server with the remote service

- Configuration - Insert the configuration name that was defined in CuttingServices.

To TCP/IP port - Insert the Address and Port.

2.9  File - Digitize
Use these options to import from:

Scanner

Image

2.9.1  File - Digitize - Scanner
This menu allows to choose if you digitizing a Shell or Parts and to select the source.

2.9.1.1   File - Digitize - Scanner - Shell
This is the option to scan a shell into the software.

1. Select Options from Digitize option of the File menu to adjust the properties, before you start
digitizing the shell; however, it's recommended to use the default values.
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2. Open Select Source from Digitize option of the File menu to select the right scanner.

3. Select Shell from the Digitize option of the File menu. Your scanner software will be launched.
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4. Adjust the scan properties and select PreScan.
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5. To finish the shell scanning press Start.

6. A dialog box will appear, insert the DPI value and click OK.

7.  The load bar will appear during the scanning process.

8. After the loading is finish the lines will be displayed on the screen.
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9. Select all the image.
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10.Now it's possible to see the lines.
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2.9.1.2   File - Digitize - Scanner - Parts
This option lets you scan one or more parts into the software.

1. Select Options from Digitize option of the File menu to adjust the properties, before you start
digitizing the part; however, it's recommended to use the default values.

2. Open Select Source from Digitize option of the File menu to select the right scanner.
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3. Select Parts from the Digitize option of the File menu. Your scanner software will be launched.

4. Adjust the scan properties and select PreScan.
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5. To finish the shell scanning press Start.

6. A dialog box will appear, insert the DPI value and click OK.

7. The load bar will appear during the scanning process.

8. Select if the part is or isn't face down.
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9. After the loading is finish the part will be displayed on the screen.

10.Select all the image.
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11.Now it's possible to see the line that composes the part.
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12.Select Create Part from the Parts menu, select the line, do a right click and select Finish.
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13. The part will be added to the Parts/Library Bar. Double click the part you just created to see it
now standalone. 
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2.9.1.3   File - Digitize - Scanner - Select Source
This option lets you select the scanner to use.

1. Select the Select Source from the Digitize option of the File menu.

2. Select if you what to use the Windows Image Acquisition or the normal interface.

3. Using the WIA to select the source 

Select the device to use and press Ok.

 

4. Using the normal interface to select the source, a list of available scanners will be displayed.

Select the required scanner and press Select.
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2.9.2  File - Digitize - Image
This menu allows to choose if you selecting an image of a Shell or a Parts.

2.9.2.1   File - Digitize - Image - Shell
1. Select Digitize - Image - Shell options of the File menu.

2. Select the file.

3. Insert the DPI.
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4. After the loading is finish the image will be displayed on the screen.

5. Select show/hide Images from the Layers options on the View menu.

Behind the image are the lines, which are editable.
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2.9.2.2   File - Digitize - Image - Parts
1. Select Digitize - Image - Parts options of the File menu.

2. Select the file.

3. Insert the DPI.
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4. Select if the part is or isn't face down.

5. After the loading is finish the image will be displayed on the screen.

6. Select show/hide Images from the Layers options on the View menu.
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7. Behind the image are the lines, which are editable.

2.9.3  File - Digitize - Options
Use this is the option to adjust the properties of the scanning software.

Filter Before Filter the points to a maximum of this value, before a spline is created

Filter After Filter the points to a maximum of this value, after a spline is created

Stuff Dist Distance between points between filter operations

Break Angle The angle between points above which a corner will be inserted in the line

X Y Define the X and Y scale when using the scanner

Import Image Enable or disable import image
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2.10  File - Project Properties
Select Project Properties from File menu, this lets you keep a record of any information regarding
your project.
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2.10.1  Project Properties - Summary

This tab allows to consult the project data, to add personal comments, change the project image or

any other information in this area.
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2.10.2  Project Properties - Material Options
Shows the material groups associated to this project and the material details. 

1. To create a new Material Group, press the button  Groups; The window new material group will
appear;

2. Insert the new material group name and press OK.

3. The group will be created, now to add material to the group, press the button  Catalogue
options; A window with all available material will open. 

4. Select the required material, press Ok and the material will be added to the group. Its possible to
add several material to the same group, to do that repeat the same process.

Note: Use CTRL to select more than one material at the same time.
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5. It's possible to edit the name and material group of the material added to the group, just do a
double click over the field to edit.  

2.10.3  Project Properties - Variants
In this tab you can find the projects variants available in the selected project.

Variants Types:
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Material Options Cost Assignment

Operations

Components

2.10.4  Project Properties - Costing results
In this area you have two automatic values, the Netresult and Fullresult of each image.

Netresult - Value obtained by the consuming calculation.

Fullresult - Is the Netresult with the factors defined by the user.

You can order by Variant or Group.
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2.10.5  Project Properties - Parts

Allows to consult all the parts in the project.

Right click over a part to access the contextual menu:

Copy - Allow to copy the selected part and past directly into MindCAD 2D Design &
Engineering.
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Open project - Opens the part project.

Search similar parts - It will use a search engine to search for parts similar to the selected one,
and show then in a new tab, Similar parts.

2.11  File - Preferences

Use this option to define the default settings of things like:

file locations

colors

language
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2.11.1  File - Preferences - Locations

Use these options to set your default file locations.
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Font Path - The directory where you keep the font that is loaded by the software on startup; it is

recommended that this option is not changed.

Shells Path - The directory where you keep your shells. Select the directory by clicking  to

display the Browse for folder dialogue box

Cut Path - The directory where you keep your files for cutting. Select the directory by clicking  to

display the Browse for folder dialogue box

Grading Library Path - The directory where your grading library is kept. Select the directory by
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clicking  to display the Browse for folder dialogue box

Library Location - The directory where your punch library is kept. Select the directory by clicking

 to display the Browse for folder dialogue box

Add - Use this option to create a new library. A lines library could be added to hold standard lines
such as heel curves. The library will be displayed in the Parts toolbar. Use the added tab in the same
way as the punch library

Remove - Use this option to remove any libraries that you have added.

Themes Path - The directory where your themes are kept. Select the directory by clicking  to

display the Browse for folder dialogue box

2.11.2  File - Preferences - Options
Use these options to set personal preferences for:

autosave

line deletion

drawing margins

export

line widths of model when drawing

default document size

keep multiple versions of documents

side

showing grading points
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A comprehensive description on available options follows: 

Autosave
If ON, your work is automatically save at the specified time
interval

Confirm deletion of

dependent lines

If ON, you will be warned if the line you are trying to delete
has other lines dependant on it

Show Scalement Points
If ON, show the grading points by default

Continuous Drawing Margin
Parts can be digitized from a tablet using a mouse with a
small 'follower'. The special cursor is tracked around the
outline of the part and this option is used to give the offset
required to offset the input points back to the original part
boundary

New lines are not exported
If ON, all new lines will not be exported to 3D Design &
Engineering
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to 3D

Use line widths of model

when drawing

Pick multiple parts

If ON, line drawing is done with the thickness specified by
the user. If OFF the thickness is equivalent to zero, the
thinnest possible line is displayed

If ON, activates pick multiple parts

Auto center view when

zooming

Enable to auto center when applying zoom. 

New Document Properties
set the default document size in millimetres

Side
set the default document side (right or left)

Keep multiple versions of

documents

If ON, activates versioning which allows for retrieval of old
versions

Number versions to keep
number of versions to be kept in the history of a document

Information on the shell -
Granding

If ON, the grading information will be displayed on shell by
default

Information on the shell -
Model Side

If ON, the model side information will be displayed on shell
by default

Draw Mode Select Fast or Quality mode. Enable or disable Auto-
degrade quality.

Monitor If the Override option are ON the user as tospecify the
dimensions of is monitor in mm.
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2.11.3  File - Preferences - Digitizer
Use these options to set the cursor keys actions when digitising with a tablet.
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2.11.4  File - Preferences - Language
Use this option to select your preferred language.



107File Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

2.11.5  File - Preferences - Default Labels
Use these options to create default text on your parts.

Text - The drop down list contains the following standard text components.

%Part% - Part name

%Number% - Part size (you need to have graded sizes for this to show)

%Model% - Shell name

%Area%m2 - Part area in square meters.

%Length%mm - Part boundary length in millimeters.
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%FileName% - The name of the scd file.

%FileDate% - Date of last modification of the file.

%Component% -  Material name.

%Dimension%mm - Provide parts dimensions.

Auto add on part creation - If ON, the text components you have selected will be automatically

added when the part is created, in the border or in the inside, depending of witch option is chosen.

Size (mm) - Height of the text in millimetres

Properties - Set a property for your text. The property will be sent to the cutter and can be used to

define the tool that is used to produce the text.

Create - Use this to add a text string to the drop down list. For further details see Adding a new text

string.

Delete - Remove unwanted strings by selecting the text and clicking this option.

2.11.5.1   Adding a new text str ing

New text strings can be added to the default labels dropdown

1. Select Create on the Default Labels tab.

2. Type in the required text in the dialogue box

3. Click OK

The text is added to the dropdown list and can be applied to parts.
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2.11.6  File - Preferences - Code
Use this option to enable or disable the code and select or create your preferred size codes for your
parts.

You can select a code file in the SCS format. Storing of a size code definitions file is possible in the

editing process using the Add button.

Custom - Create you own custom size codes, using the Add button.

Rounded Code - Set a small round on all the code shapes. When the code is cut, the cutter will not

keep lifting the knife.

Code spacing - Sets the spacing between elements of the size code

Code width - Sets the width of the size code in millimetres

Code height - Sets the height of the size code in millimetres
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2.11.6.1   Custom size codes
You can create and edit custom size codes button

1. Activate Add, a code definition dialog appears

2. Select the grading type.

3. Select the size.

4. Create the code definition using the symbol buttons

5. to remove already inserted symbols use the arrow buttons . 

The code file should be saved with a SCS file extension.

2.11.7  File - Preferences - Parts 1
Use these options to set the default settings for:

Groups

Names

Inside indicator

Last allowance

Notches on Mirrored Parts

Generate quality areas automatically 
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2.11.7.1   File - Preferences - Parts - Groups

Use this option to create materials. These materials can be applied as a section of the text on your

finished parts.

Groups - Select the required group from group from the drop down list.

Color - Select this option if you want parts with the same group to be the same color.

 - Click "+" to open a dialogue box that allows you to create a new group name that will be added

to the Groups drop down list. Enter the name in the dialogue box and click OK.
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2.11.7.2   File - Preferences - Parts - Inside Indicator

Use this option to give the default values for your inside indicator.

Select one of the following as the Inside Indicator. Specify the appropriate value in the

corresponding box.

None - No inside indicator

Triangular - Display notch as the inside indicator.

Rectangular - Display rectangle as the inside indicator.

Arc - Display arc as the inside indicator.

2.11.7.3   File - Preferences - Parts - Last allowance

Use these options to create default lasting allowance tables.

Create last allowances - Select this option if you want to automatically add a lasting allowance

when importing a BGD file from 3D Design & Engineering. Lasting allowances do not grade.

Add - Click to create a new lasting allowance. The lasting allowance is defined using a series of

dialogue boxes.

1. Name - Enter a Name and click OK.
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2. Inside Values: - Enter values for the lasting allowance on the inside of the shoe. The first value is
at the toe and the last value is at the heel. Any other values are spaced equally along the feather
edge.

Click OK

3. Outside Values: - Enter values for the lasting allowance on the outside of the shoe. The first value
is at the toe and the last value is at the heel. Any other values are spaced equally along the
feather edge.

Click OK

The name and associated values of the lasting allowance you have defined is displayed in the

dialogue box and can be selected when a MCD file is imported.

2.11.7.4   File - Preferences - Parts - Notches on mirrored parts

Use this option to automatically create centre notches on parts. This only works if the shell is

'folded'.

None - If ON, do not create centre notches on parts.

Oblique - If ON, add an oblique notch to the centre of a part automatically. If you use this option you

will need to set a default depth and curvature.

Depth - Depth of the notch in millimetres.

Curve - This value makes the notch angular or curved. A value of 0 will result in sharp corners on the

notch.
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2.11.7.5   File - Preferences - Generate Quality Areas Automaticaly
Use this option to enable or disable automatically generation of quality areas.

2.11.7.6   File - Preferences - Parts - Names

Use this option to select the names and materials to be applied as a section of the text on your

finished parts.

Name - Select the required name from the drop down list.

Material - Select the required material from the drop down list. The parts with the Name you have

selected will use the material you select in this option.

Color - Select this option if you want parts with the same material to be the same color.

Create - Click Create to open a dialogue box that allows you to create a new name that will be

added to the Name drop down list. Enter the new material name in the dialogue box and click OK

2.11.8  File - Preferences - Parts 2
Use these options to set the default settings for:

Rotation

Reference points

Post-processing part filtering

Default stencils margin

Name template

Part assessment
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2.11.8.1   File - Preferences - Rotation
Allows to define the rotation angles for auto nesting. 

After inserting the Angle and Range, click "+" button, to add the new angle range.

To delete an angle range, select it and press "-" button. 

All the parts created after this change will be by default with this rotation angles. This can be also
configured individually in the parts properties.
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2.11.8.2   File - Preferences - Reference points
This option allows to add predefined reference points automatically when creating parts.  

Create: Select where to create the points, On Center (one point in the part center), On Vertical Axis
(two points in the part vertical axis), On Horizontal Axis (two points in the part horizontal axis), by
Bounding (four points, one in each corner of parts the bounding box). 

Shape: Select the points shape from, Circle, Square, Cross, Square chess or Round chess.

Size: Select the points size. 

Margin: Select the points margin (from the part) in mm.

2.11.8.3   File - Preferences - Post-processing part filtering
Enable or disable the post-processing part filtering option for the. This is effective for new parts
(created after handling this settings).

The post-processing is defined in the parts properties tab.

2.11.8.4   File - Preferences - Default stencils margin
Allows to control the stencils margins, when cutting the part. 

This can be also configured individually in the parts properties.

2.11.8.5   File - Preferences - Name template
This option allows to assign automatically names to parts.  

The default value is M%S in this case the parts name will appear, like M1, M2 depending in which
slot they are assigned.
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If the part changes to other slot, the name will change, in this example from M4 to M5.

2.11.8.6   File - Preferences - Part assessment
Use this option to define a preferred part assessment method and part margin.

Method: Several interlock costing techniques can be used;

There are several methods:

Parts Margin: Adds a margin in mm between parts;
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2.11.9  File - Preferences - Grading
Use these options to set (default) grading.

default grading type and complexity 

show advanced grading options

show grading information on shell

ask for base size when creating model

group grading

Default grading type Use the drop down list to select your default
grading system as English or Continental

Grading types defaults Activating this button will allow the configuration of
a custom scale where increments could be inserted
in the following dialog

Always show advanced grading
options

 If ON, the grading table in the 'advanced' mode will
be displayed by default

Ask for base size when creating If ON, when we create a new model, the base size
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model will be asked

Group grading create and edit grading groups for special grading
applied to parts and lines

Type select grading type for a group

From initial group size

To final group size

Use grade group like for this size

2.11.9.1   Adding a Grading Type
Using the Grading Types Defaults button under Preferences/Grading tabulator a dialog will appear
to manage the process

New It allows the creation of new grading types
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Name enter the name of new grading type

Stepping enable the stepping

Size ranges Define values of the start, end, inc.X and inc.Y

Clone Duplicate a grading type

Delete Delete a grading type

Abbr. Name Shorthand for size when outputting to cutting machines (ex. size 37 ->
short 7)

2.11.9.2   Adding a Group Grading Rule
Activate Add Group button to insert another group grading rule.

As a sample do input the displayed values
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2.11.9.3   Adding a Grading Rule
Activate Add Rule button and a new group grading rule is inserted on the list.

Remove Rule - remove the selected grading group rule.

Edit Rule - edit the selected grading group rule.

2.11.10  File - Preferences - Printer
Use these options to set some printer control:

Control colour

Control scale

Enable or disable use lines widths of model when printing

Pen width

Enable or disable print file data

Enable or disable print file name
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2.11.11  File - Preferences - Default Properties/Layers
Use these options to create and set default properties and Layers for lines, parts, punches.
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2.11.12  File - Preferences - Customize
Use these options to choose or configure the application theme, and the popup menus.

2.11.12.1   Editing Theme
Use these options to edit a theme.

1. To duplicate a theme, select one of the existing one and press Duplicate.

2. To customize a theme, select Customize.
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Note: If the buttons of the theme option aren't available, it's because the themes path is not defined
yet. So please go to File - Preferences - Location and select the themes path.

3. All the visual environment parameters can be changed for this new theme.

2.11.12.2   Popup menus
Use these options to customize popup menus .

1. Select customize (popup menus) and open the Menu drop down list.
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In this list, the available tools in which the popup menu could be configured.

2. Using the Clear Menu button will in fact, remove all the default items of the menu.

3. Using the Add Separator button will add a separator for better organization of the menu

4. On the Top Level Menu section a drop down list is available with the default top level menus.
After selection, use the Add button for insertion of the entire top level menu and its children. To
remove the item, just select  it on the tree view on the left and press the Del key.
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Follows a sample of an insertion of the top level menu Parts on a popup menu.

   

5. On the Menu item section a drop down list is available with all the menu entries. After selection,
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use the Add button for insertion. To remove the item, just select it on the tree view on the left and
press the Del key.

 

   

Follows a sample of an insertion of the Print Parts menu entry on a popup menu.

   

6. On the Popup section it is possible to create a new sub menu by simply writing its name and
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pressing the Add button. To remove the item, just select it on the tree view on the left and press the
Del key.

It´s possible to add child items using the previously described options, by selecting the created sub
menu on the tree view on the left.

   

Follows a sample of an insertion of the Manage Cutters menu entry on the sub menu called Sub
Menu on a popup menu.
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7. On the Predefined menu group section a drop down list is available with the available settings
groups. After selection, use the Add button for insertion. To remove the item, just select it on the
tree view on the left and press the Del key
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Follows a sample of an insertion of the Treatment settings group, just after the sub menu called
Sub Menu, on a popup menu.
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8. It’s possible to change the order of the inserted items by simply selecting and drag-and-dropping it
in the new position.
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2.12  File - Printing
This menu allows to control the printing options.

2.12.1  File - Page Setup
Use this option to control the printing of the current shell.

1. with the mouse we can control the pages locations related to the model, click over the page and
drag it.

2. with Shift and mouse left click the operator can enable or disable the pages to be printed.
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2.12.2  File - Print
Use this option to print the current shell.

This is the same as clicking the Print  button in the Main toolbar or pressing Ctrl+P

2.12.3  File - Print Parts
Use this option to print your parts.

Select Models, Groups, Parts and Sizes to print.

2.12.4  File - Print Prev iew
Use this option to preview a print out.
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2.12.5  File - Printer Setup
Use this option to set up your printer.

2.13  File - Exit
Use this option to exit the program.
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3  Edit Overview
This menu lets you carry out some of the editing commands, it also allows you to undo edits that
have been made, and restrict editing of items that are correct.

3.1  Edit - Undo
This option undoes the last editing command.

This is the same as clicking the Undo  button in the Main toolbar or pressing Ctrl+Z.
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3.2  Edit - Redo
This option redoes the last undo command.

This is the same as clicking the Redo  button in the Main toolbar or pressing Ctrl+Y

3.3  Edit - Cut
This option cuts the currently selected items. Cut copies the selected items to the clipboard, then
deletes the selected items.

This is the same as clicking the Cut  button in the Main toolbar or pressing Ctrl+X

3.4  Edit - Copy
This option copies the currently selected items into the clipboard.

This is the same as clicking the Copy  button in the Main toolbar or pressing Ctrl+C

3.5  Edit - Paste
This option pastes the contents of the clipboard (filled by Cut or Copy) into the current window and
leaves it active so it can be moved to a new position. Drag the contents of the clipboard and place
using the left mouse button.

This is the same as clicking the Paste  button in the Main toolbar or pressing Ctrl+V
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3.6  Edit - Fixed Paste
This option pastes the contents of the clipboard (filled by Cut or Copy) into the current window in its
original position

3.7  Edit - Delete

This option deletes the currently selected items. This is the same as pressing the Delete key
on your keyboard.

3.8  Edit - Select All
This option selects all items. This is the same as pressing Ctrl+A

3.9  Edit - Reverse Selection
This option reverses the current selected items. If you want to select all items except a number of
lines, select the lines you do not want to select and use this option. This is the same as pressing 
Ctrl+Shift+W

3.10  Edit - Group
This option lets you treat a number of lines as a single object. If any line within a group is selected
all the other lines in the group will be selected as well.

1. Select the lines that you wish to make into a group.

2. Select Group from the Edit Menu  .

3.11  Edit - Ungroup
This option lets you return lines within a group to individual lines.

1. Select any line in a group.

2. Select Ungroup from the Edit Menu .
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3.12  Edit - Freezings
This option lets you Freeze and Unfreeze lines. If lines are frozen, they cannot be edited, use
Unfreeze to make them available for editing.

Freeze all - Freeze all lines.

Freeze selection - Freeze the selected lines or pressing Ctrl+F.

Freeze all but selection - Freeze all lines except the selected lines.

Unfreeze all - Unfreeze all lines or pressing Ctrl+Shift+F.

3.13  Edit - Constrain Edit
Set of options that enable you 'snap' editing or drawing operations to specific points. You can use
any combination of the Nearest options together. This lets you select all options if you want the
snap options to work to their full capabilities.

3.13.1  Edit - Constrain Edit - Nearest Line
Use this option to make all editing and drawing operations snap to the nearest line, when the cursor
is close to it.

This is the same as clicking the Constrain Edit Nearest Line button in the Constrain
toolbar or pressing H

Snap to the Nearest Line: 
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3.13.2  Edit - Constrain Edit - Nearest Intersection
Use this option to make all editing and drawing operations snap to the nearest intersection between
lines, when the cursor is close to it.

This is the same as clicking the Constrain Edit Nearest Intersection  button in the
Constrain toolbar or pressing K

Snap to the Nearest Intersection: 

3.13.3  Edit - Constrain Edit - Nearest End
Use this option to make all editing and drawing operations snap to the nearest line end, when the
cursor is close to it.

This is the same as clicking the Constrain Edit Nearest End  button in the Constrain
toolbar or pressing L
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Snap to the Nearest End:

3.13.4  Edit - Constrain Edit - Nearest Point
Use this option to make all editing and drawing operations snap to the nearest point on a line and to
the geometric centre on symmetry shapes when the cursor is close to it.

This is the same as clicking the Constrain Edit Nearest Point  button in the Constrain
toolbar or pressing J

Snap to the Nearest Point: 

Snap to the geometric centre on symmetry shapes:
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3.13.5  Edit - Constrain Edit - Grid
Use this option to make all editing and drawing operations snap to the grid when the cursor is close
to it. In addition,

When the cursor is on a grid line, the grid is displayed in blue.

When the cursor is on a grid intersection, grid intersection is displayed in red.

This is the same as clicking the Constrain Edit Nearest Grid  button in the Constrain
toolbar or pressing G

Snap to the Nearest Grid:

3.13.6  Edit - Constrain Edit - Orthogonal Restriction
1. Select the desired constrain editions.

2. Start drawing a line, after doing the first point if you move the mouse courser the line will move
freely, but if you press SHIFT key the orthogonal restriction is activated.
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3. With the SHIFT key pressed, when you're moving the line, it will just move the specific places.

4. In the image below you can see the possible angles with the orthogonal restriction activated.

3.14  Edit - Drag Constrain
This lets you control whether a line(s) can be dragged (moved), rotated or scaled.

If Drag Constrain is OFF,
Lines can be dragged, rotated and scaled when the cursor is over a line(s) and displayed as a

cross 

If Drag Constrain is ON,

Lines cannot be dragged, rotated or scaled.

It is only possible to move points in a line. This means whole lines do not accidentally get dragged
to a new position.
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3.15  Edit - Pre-copy
Use this option to copy a line or lines before editing them.

1. Select the lines.

2. Select Pre-copy from the Edit menu  or pressing Ctrl+Shift+C.

3. Edit the lines as required. The original lines are left untouched and the new lines are modified.

3.16  Edit - Digitize

This lets you digitize lines from a tablet . To return to using the cursor, select the option
again.

3.17  Edit - Alignment Points
Use this option to align the reference points of the current shell and the physical reference points on
the digitizer.

A sample sequence follows:

1. define two reference points on the working shell.

2. define the same two points now on the digitizer for the alignment.

3. clear the alignment points.
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3.18  Edit - Properties
This displays the current document size in mm and side. To change the document size, type in the
new values required and side.

It's possible to display notes in the project load, in order to do that:

1. Write the notes for the project in the text box.

2. Select the option display notes box on load.
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3. Press Ok and save the document changes.

4. When someone opens the project the message will be displayed.
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4  View Overview
This menu lets you control what is displayed on the screen

You can use it to turn on or off the following

toolbars

layers

filters

grid

4.1  View - Zoom to Fit
This option lets you scale any graphics, so that it fits onto the screen. This is the same as clicking

the Zoom to fit button  in the Main toolbar or pressing Ctrl+D

In addition to Zoom to fit, you can add the following buttons to your customised toolbar

 Zoom in x 2 - A rectangle is displayed with a magnifying glass at the centre, place the
magnifying glass at the point you want to centre, and press the left mouse button. The scale will be
increased by 2.

 Zoom in x 4 - A rectangle is displayed with a magnifying glass at the centre, place the
magnifying glass at the point you want to centre, and press the left mouse button. The scale will be
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increased by 4.

 Zoom out x 2 - select this option to reduce the scale by a factor of 2.

 Zoom out x 4 - select this option to reduce the scale by a factor of 4.

4.1.1  View - Zoom to Fit to selected elements
To zoom to fit to selected elements:

1. Select the desired elements.

Click the Zoom to fit button  in the Main toolbar or pressing Ctrl+D
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4.2  View - Zoom 1:1
When this option is used, the graphics are scaled to the correct physical dimensions. This is the

same as clicking the Zoom 1:1 button  in the Main toolbar or pressing Ctrl+Shift+D.

 

If Zoom 1:1 doesn't work correctly please go to the File-Preferences-Options and specify the correct
value (in mm) of your monitor.



153View Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

4.3  View - Toolbars
Use this option to select the toolbars that are displayed.

4.3.1  View - Toolbars - Main
Use this option to turn on/off the main toolbar. It is recommended that this menu is displayed at all
times.

4.3.2  View - Toolbars - Constrain
Use this option to turn on/off the constrain toolbar. It is recommended that this menu is displayed at
all times.

4.3.3  View - Toolbars - Layers
Use this option to turn on/off the layers toolbar. It is recommended that this menu is displayed at all
times.

Where there is more than one project open, there will be one layer toolbar for each project.
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4.3.4  View - Toolbars - Grading
Use this option to turn on/off the grading toolbar. It is recommended that this menu is displayed at all
times.

4.3.5  View - Toolbars - Tools
Use this option to turn on/off the tools toolbar. It is recommended that this menu is displayed at all
times.

4.3.6  View - Toolbars - Parts
Use this option to turn on/off the parts toolbar. It is recommended that this menu is displayed at all
times.

4.3.7  View - Toolbars - Browser
Use this option to hide/display the browser bar.

Click in  to see the normal line coloring 
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Click in  to see the line coloring by layer (to add more layers go to File - Preferences - Default
Properties/Layers)

Click in  to see the line coloring by properties (to add more properties go to File - Preferences
- Default Properties/Layers)

Click in  to see the line coloring by dependencies 

Use this option to turn On /Off  the parts layer.

Use this option to turn On /Off  the parts properties layer.

Use this option to turn On /Off  layer by layers, those are:

- image layer ( 0 ), construction lines (Construction), style lines (Design) and lining lines
(Lining).

4.3.8  View - Toolbars - Parts/Library Bar
Use this option to turn on/off the Parts/Library toolbar. It is recommended that this menu is displayed
at all times.
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4.3.9  View - Toolbars - Customize
This allows advanced interface customization.
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4.3.9.1   View - Toolbars - Customize - Commands
In the commands tab are available all the program commands, arranged by Categories.

The user can drag any command to the toolbars.
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4.3.9.2   View - Toolbars - Customize - Toolbars
Use these options to create your own toolbars and to reset the existing ones.

To add a customized toolbar please follow this sequence:

1. On the Toolbars tab, click New

2. Insert the name and press OK, the new bar will appear.

3. In the commands tab are available all the program commands, arranged by Categories
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4. Select the required command button and Drag and drop to the toolbar. To drag the command,
click over it with the left mouse button and keep it pressed

5. When the mouse button is over the toolbar, you can let go of the left mouse button
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6. The button will be added to the toolbar

 

7. To remove a button from the current toolbar, select the button and drag and drop it to the
commands list.

4.3.9.3   View - Toolbars - Customize - Keyboard
This option allows you to create your one keyboard shortcuts. 

1. Select the Category and the Command to add the shortcut.
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2. Select the text box Press New Shortcut Key  and press keys to assign to add the shortcut.

3. To remove the shortcut, select it and press Remove.
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4. The button Reset All allows to set the original shortcut and delete the custom ones.

4.3.9.4   View - Toolbars - Customize - Menu
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Application Frame Menus

Select the desired menu to reset from the "Show menus for:" 

After selecting the menu, press the Reset button, when you do that the menus will return to the
original state. 

Menu Animations 

It's possible to select animations for the menus.
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4.3.9.5   View - Toolbars - Customize - Options

Toolbar

Show Screen Tips on toolbars - Enable/ Disable the tooltips

   - Show shortcut keys in Screen Tips - This option is available only when the Show Screen Tips
on toolbars is enable.

Large icons - Select this option to see the icons larger.

Normal icons  Large icons
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4.4  View - Layers
Use this to show the options for displaying layers

The available layers are:

Lines

Parts

Punches

Notches

Markers

Images

Grading Centres

Grading Points

Alignment Points

4.4.1  View - Layers - Lines

Use this option to turn on/off all lines. This is the same as clicking the All Lines  button in the
Layers toolbar.

4.4.2  View - Layers - Parts
Use this option to turn on/off the parts layer.

This is the same as clicking the Parts  button in the Layers toolbar
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4.4.3  View - Layers - Punches
Use this option to turn on/off the punches layer.

This is the same as clicking the Punches  button in the Layers toolbar

4.4.4  View - Layers - Markers
Use this option to turn on/off the markers layer.

This is the same as clicking the Markers  button in the Layers toolbar.

4.4.5  View - Layers - Notches
Use this option to turn on/off the notches layer.

This is the same as clicking the Notches  button in the Layers toolbar

4.4.6  View - Layers - Images
Use this option to turn on/off the images layer.

This is the same as clicking the Images  button in the Layers toolbar

4.4.7  View - Layers - Grading Centres

Use this option to turn on/off the grading centres layer. 

Note: If this option is not available, please go to File-Preferences-Customize and the layer to a
customized toolbar.
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4.4.8  View - Layers - Grading Points

Use this option to turn on/off the alignment points.

Note: If this option is not available, please go to File-Preferences-Customize and the layer to a
customized toolbar.

4.4.9  View - Layers - Alignment Points
Use this option to turn on/off the reference points. 

4.5  View - Filters
Use this to hide or show lines.

Hide all - Hide all lines.

Hide selection - Hide the selected lines, or press Ctrl+U

Hide all aut selection - Hide all lines except the selected lines. Alternatively, press Ctrl+R

Show all - Show all lines. Alternatively, press Ctrl+W

Reverse - Reverse the show/hide selection. Alternatively, press Ctrl+Shift+W

4.6  View - Grid
Use this option to control how the grid is displayed and the spacing of the lines within the grid.
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4.6.1  View - Grid - Lines
Use this option to display the grid as a series of dashed lines.

4.6.2  View - Grid - Points
Use this option to display the grid with points at the grid intersections only.

4.6.3  View - Grid - None
Use this option to turn off the grid.

4.6.4  View - Grid - Spacing
Use this option change the spacing of the lines within the grid.

Spacing - Enter the in the value required.
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4.7  View - Full Screen
Use this option to view only graphics, so that it fits onto the screen.

This is the same as pressing F3, repeat the operation to return to normal viewing mode.





Part

V
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5  Tools Overview
This menu lets you carry out all selection operations, draw lines, edit lines, make measurements
and copying properties between objects.

.

The available options are:

Make selections

Draw lines

Edit lines

Measure on screen

Copy Properties

5.1  Tools - Selection
Use this option to select any object (for example, line, part, punch ).

This is the same as clicking the Selection  button in the Tools toolbar.

1. select Selection from the Tools menu. The cursor will be displayed 

2. select the object using the left mouse button. The selected object will highlight.

5.1.1  Tools - Selection - Point selection
It is possible to select an individual point or points on a line. This is required in some operations.

1. Select Selection from the Tools menu. The cursor will be displayed 

2. Select the line with the point(s) to be selected.
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3. Hold down the Shift key and click the left mouse button to make a polygon around the required
points. As the points are selected they highlight.

4. Releasing the Shift key will finish the polygon creation; these points can now be edited.
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5.2  Tools - Drawing
This menu contains all the options for drawing lines. 

To quickly visualize some information about any object, simply press the I key and hover on the
object (to deactivate this query mode just press the I again). 

For detailed information do a right click over the object and select Properties.

In the properties window there are two tabs:

Properties:
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ID: Number representing the object identity.

Name: Is possible to assign a name to the object. 

Color: Select the line color, from the available options. 

Style: Choose the style for the line.

Width: Allows to change the line width in mm. 

Layer: Select the object layer, press button [...] to see the available layers.

Side: Allows to define in what side the object should be. Press button [...] to choose the side.

Linked to 3D: Check to link with 3D. 

Properties: Allows to add properties to the object.

Dependencies:
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In this tab is visible if the object as dependencies, this is, if is used in parts, if as parallels
associated, etc. 

Is also possible to quick select the dependent parts. The matching part will be visible on the model. 
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5.2.1  Tools - Drawing - Line
Use this option to draw lines. By default the lines will be curved, but corners can be added at any
time, using the Tool Options menu.

This is the same as clicking the Create Line  button in the Tools toolbar or pressing Ctrl+L.

5.2.1.1   Creating a curved line
1. Select Line from the Drawing options of the Tools Menu. The cursor will be displayed as a

cross 

2. Insert points using the left mouse button.

3. It's possible to insert the line points in a specific places, based in X,Y coordinates. To do that,
press the key A or do a right click and select Add point from the contextual menu.

a. Insert the X coordinates and press Enter.

b. Insert the Y coordinates, press Enter. 

c. The point will be placed.
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4. To finish the line,  do double click with the left mouse button, or press Enter, or do a right click
and select Finish from the contextual menu.

5.2.1.2   Creating a curved line with corner
1. Select Line from the Drawing options of the Tools menu. The cursor will be displayed as a

cross 

2. Insert points using the left mouse button.

3. To add a corner,

§ Press Ctrl as you add the point

§ With the cursor in the correct position for the point, press the right mouse button and select 
Add Corner from the menu
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4. Continue drawing the line. The corner option can be used repeatedly in any line to create a zigzag
effect.

5. To finish the line either double click the left mouse button or press the right mouse button and
select Finish from the menu

5.2.1.3   Creating a closed curve
1. Select Line from the Drawing options of the Tools menu. The cursor will be displayed as a

cross 

2. Select Closed Curve from the Tool Options toolbar.

3. Insert points using the left mouse button.
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4. To finish the line either double click the left mouse button or press the right mouse button and
select Finish from the menu

.

Tips

1. Use as few points as you can to create your desired curve.

2. Avoid drawing across the centre line if possible, as these lines will not be give the desired result
when 'mirrored'

3. Use the snap functions in the Constrain menu to keep lines (points) accurate.

5.2.1.4   Line editing
You can edit a line in the following ways:

Move a point

Add/Delete a point

Changing a Corner/Curve point

Dragging/Scaling/Rotating lines/Mirror
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5.2.1.4.1  Line editing - Move point

1. Select Object selection from the Selection options on the Tools menu. The cursor will be

displayed 

2. Select the line to be edited. As you approach a point on the selected line the cursor will change to
a pen.

3. Press and hold down the left mouse button, as you move the mouse the point will move.

4. To finish the edit release the left mouse button.

5. Repeat on any point on the selected line.

5.2.1.4.2  Line editing - Select points

1. Draw a line

2. Hold down the CTRL button, approach the point to be selected the cursor will change to a pen (

).

3. Select the desired point.
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4. The selected points are shown in blue.

5. It's possible to edit just the selected points. For example rotate just the select points.

5.2.1.4.3  Line editing - Add/Delete point

To add a point to a line

1. Select Object Selection from the Selection options on the Tools menu. The cursor will be

displayed .

2. Select the line to be edited.

3. Hold down the Shift key, approach the selected line between original points, the cursor will

change to a pen with a plus sign. 

4. Press the left mouse button to add a point at this position.

To delete a point from a line
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1. Select Object Selection from the Selection options on the Tools menu. The cursor will be

displayed .

2. Select the line to be edited.

3. Hold down the Shift key, approach the point to be deleted, the cursor will change to a pen with a

minus sign.

4. Press the left mouse button to delete the point.

5.2.1.4.4  Line editing - Changing a Corner/Curve point

1. Select Object Selection from the Selection options on the Tools menu. The cursor will be

displayed .

2. Select the line to be edited.

3. Move the cursor towards the point to be edited and get the pen cursor displayed.

4. Press the right mouse button and select the Change corner/curve option from the menu.

5.2.1.4.5  Line editing - Dragging/Scaling/Rotating lines/Mirror

Full information on Drag Constrain is in the Edit chapter.

Click here for information on Drag Constrain.

1. Select Object Selection from the Selection options of the Tools Menu. The cursor will be

displayed .

2. Select the line(s) to be edited.
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3. With the pointed cursor displayed , click the left mouse button and hold it down to drag the
lines.

4. Hold down the Ctrl button and click the right mouse button to select the rotation point.

5. Click the left mouse button to start rotation. Move the cursor to rotate the line(s)

6. Click the left mouse button to finish.

For further information, see Edit - Drag Constrain.

5.2.1.4.6  Line editing - Virtual Mirror

It is possible to do a mirror of selected geometry without having to select an axis. This is provided for
a quicker interaction. To do this, the operator should:

1. select line(s) to mirror.

2. press the right mouse button and select the Mirror option from the menu.

The lines are mirrored around a virtual axis, automatically defined, based on the selected geometry.

5.2.1.4.7  Line editing - Arrow Movement Step

This tool allows the user to configure the value in mm that the line will be moved, each time, when
moving the line with the keyboard arrows.

1. Select a line.

2. Do a right click and select Arrow Movement step.

3. Insert the step value.
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4. Now when the keyboard arrows are pressed the line will move 1 mm in the direction of the arrow
pressed.

5.2.2  Tools - Drawing - Bezier

This is the same as clicking the Bezier line  button in the Tools toolbar.

With this type of line it's possible to have better control the direction of tangents to each of the
control points of the line.

1. Select Bezier Line from the Tools - Drawing Menu. The cursor will be displayed as a cross.

2. Insert points using the left mouse button, by default the simple point will be corner points.

3.  To control the point tangent during the line creation, press down the left mouse button and move
de mouse until have the desired curvature.

4.  To finish the line either double click the left mouse button or press the right mouse button and
select finish from the menu
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5.2.2.1   Bezier Line Editing

1. Select the button Select from the Tools toolbar. The cursor will be displayed .

2. Select the line to be edited. As you approach a point on the selected line the cursor will change to
a pen.

3. Select the point to edit. Doing a left click over it. Now the tangent is visible. 

4. Press and hold down the left mouse button, as you move the mouse the point tangent will move.

5. Hold down the Shift key and hold down the left mouse button, as you move the mouse the
direction of tangents will match.



187Tools Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

6. Hold down the Shift+Ctrl key and hold down the left mouse button, as you move the mouse. You
can see that now its possible to change one side length without interfering with the length of the
other side. 

7. Repeat on any point on the selected line.

5.2.3  Tools - Drawing - Circle

Use this option to draw circles freehand or by a given radius  .

5.2.3.1   Drawing - Circle - Free
1. Select Circle from the Drawing options of the Tools menu. The cursor will be displayed as a

cross .

2. Select Free from the Circle options

3. Insert a point using the left mouse button. This point will be the centre of the circle. As you move
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the mouse the size of the circle will change.

4. Press the left mouse button again to complete the operation.

5.2.3.2   Drawing - Circle - By radius
1. Select Circle from the Drawing options of the Tools menu. The cursor will be displayed as a

cross .

2. Select By radius from the Circle options

3. Select the radius required using the up/down arrows.

4. Insert a point(s) using the left mouse button. This point(s) will be the centre of the circle of your
specified radius.

5.2.3.3   Circle Properties
To access the circle properties:

Select the circle;

Do a right click over it;

And select Properties from the contextual menu.



189Tools Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

The Properties window will be displayed.
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ID: Number representing the Circle identity.

Name: Is possible to assign a name to the circle. 

Color: Select the circle line color, from the available options. 

Style: Choose the style for the line.

Width: Allows to change the line width in mm. 

Fill Color: Check to fill in the closed shape.

Color: Select the color to fill the shape. 

Layer: Select the circle layer, press button [...] to see the available layers.

Side: Allows to define in what side the circle should be. Press button [...] to choose the side.
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Linked to 3D: Check to link with 3D. 

Properties: Allows to add properties to the circle.

Center: Allows to change the circle center to a different position.

Radius: Allows to change the circle radius.

Dependencies Tab: 

In this tab is visible if the shape as dependencies, this is, if is used in parts, if as parallels
associated, etc. 
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5.2.4  Tools - Drawing - Rectangle
Use this option to draw rectangles.

1. Select Rectangle from the Drawing options of the Tools menu . The cursor will be

displayed as a cross .

2. Insert a point using the left mouse button. Move the mouse to give the diagonally opposite corner
of rectangle and press the left mouse button again to complete the operation. 

3. If By dimensions, enter the Width and Height in mm.

And select the rectangle alignment. 

The corner or edge of the rectangle specified by the alignment option is placed at the position
selected by the left mouse button click.
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After its creation, the rectangle has 3 control points for enhanced shape control. The original corner
control handle, given on creation, will control width and height of the rectangle, maintaining angle
directions. The third control point will allow you to rotate and change the width and height, using the
first given handle has the anchor handle.

5.2.4.1   Rectangle Properties
To access the rectangle properties:

Select the rectangle;

Do a right click over it;

And select Properties from the contextual menu.

The Properties window will be displayed.
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ID: Number representing the Rectangle identity.

Name: Is possible to assign a name to the rectangle. 

Color: Select the rectangle line color, from the available options. 

Style: Choose the style for the line.
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Width: Allows to change the line width in mm. 

Fill Color: Check to fill in the closed shape.

Color: Select the color to fill the shape. 

Layer: Select the rectangle layer, press button [...] to see the available layers.

Side: Allows to define in what side the rectangle should be. Press button [...] to choose the side.

Linked to 3D: Check to link with 3D. 

Properties: Allows to add properties to the rectangle.

Center: Allows to change the rectangle center to a different position.

Width: Allows to change the rectangle width.

Height: Allows to change the rectangle height.

Dependencies Tab: 
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In this tab is visible if the shape as dependencies, this is, if is used in parts, if as parallels
associated, etc. 

5.2.5  Tools - Drawing - Arc
This option lets you arcs. An arc is the arc of a circle. If you draw three points using the normal line
drawing it will not be an arc.

1. Select Arc from the Drawing options of the Tools menu . The cursor will be displayed as a

cross .

2. Insert three points to define the arc.

3. Repeat if required.

5.2.6  Tools - Drawing - Text
This option lets you add text to your shell (not parts).

1. Select Text from the Drawing options of the Tools menu . The cursor will be displayed as

a cross .
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2. Insert the start point for your text with the left mouse button. A dialogue box is displayed

3. Insert Text and size of text (Height)

4. Select OK

5.2.7  Tools - Drawing - Text (True Type)
This option lets you add text to your shell (not parts).

1. Select Text (True type) from the Drawing options of the Tools menu . The cursor will be

displayed as a cross .

2. Insert the start point for your text with the left mouse button. A dialogue box is displayed

3. Insert Text, Font type, Size of text, scaleX, spacing between the letters, the orientation, the
horizontal and vertical alignment, and the shear to be applied. 

4. Select OK

In alternative it's possible to add text to a line.
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1. Select the line.

2. Select Text (True type) from the Drawing options of the Tools menu 

3. A dialogue box is displayed

5. Insert Text, Font type, Size of text and select OK.

6. Now the text will move when the line is moved.
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5.2.7.1   Text (True Type) Edition
1. Select the text to edit.

2. In the Tool Options, select the Text tab.

3. Any option you change will be automatically applied to the selected text.



200 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

5.2.8  Tools - Drawing - Sawtooth
Use this option to draw sawtooth lines (zigzag lines).

1. Select Sawtooth Line from the Drawing options of the Tools menu . The cursor will be

displayed as a cross .

2. Insert points using the left mouse button.
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While drawing the line you can press the right mouse button and use the options to change the
sawtooth line width and depth

3. To finish the line either double click the left mouse button or press the right mouse button and
select Finish from the menu

5.2.8.1   Tools - Drawing - Sawtooth - Edit
Use this option to edit sawtooth lines (zigzag lines).

Select Sawtooth line, using the right mouse button and select change or pressing F12.
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1. Select Sawtooth Type (Triangular, Rectangular, Elipse, Arc or User defined).

2. Define the Balance and Roundness by moving the slide in the bar. 

3. By Width (enter the start and end width), or By Number (enter the number).

4. Enter the Start and End Depth.

5. Centered - Enable or disable centered sawtooth.

6. Start and End Distance - Insert the original start and end line distance.

7. Reverse -  Enable or disable reverse sawtooth.

8. Rounded -  Enable or disable rounded sawtooth.

9. Morph geometry - Enable or disable the morph geometry.

Morph option Off: Morph option On:
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10.On Section -  Enable or disable sawtooth on section.

11.Initial and Final Margin - Insert the initial and final margin value for on section sawtooths. 

5.2.8.2   Tools - Drawing - Sawtooth over Line
1. Select the line.

2. Select Sawtooth Line from the Drawing options of the Tools menu .

3. Now the sawtooth will move when the line is moved.
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When a sawtooth is drawn over a line it's possible to set a section.

1. Draw 3 lines, one for apply the sawtooth and two to define the section. 
2. Select the line to apply the sawtooth and apply it.

3. Go to the sawtooth tool options, select the option On Section and select the lines that will
compose the section.

4. When one of the lines is moved the section is automatically updated.

Note: Now that the sawtooth is created over a line, its possible to add punches, those will be
synchronized with the sawtooth. For further information go to Punches over Sawtooth.

5.2.9  Tools - Drawing - Axis
This option lets you to draw axis lines. An axis is used to mirror lines across, or for grading. There is
always an axis down the centre of the shoe. If you do not have at least one axis, you will not be able
to grade your shell.

1. Select Axis from the Drawing options of the Tools menu . The cursor will be displayed as
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a cross .

2. Insert two points to define the axis.

The main axis of a shell is displayed with a diamond shape at its start - see above.

5.2.10  Tools - Drawing - Marks
This option lets you to draw marks.

1. Select Marks from the Drawing options of the Tools menu . The cursor will be displayed as

a cross .

2. Insert a points(s) using the left mouse button.

Marks (small crosses) are added to each point input. Marks can be used as reference points to
either check or construct other lines.
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5.2.11  Tools - Drawing - Punches
This option lets you to draw punches.

1. Select Punches from the Drawing options of the Tools menu . The cursor will be displayed

as a cross .

2. Select a punch shape in the punches tab of the Parts/Library bar using the left mouse button.

3. Insert one or more points using the left mouse button, a punch shape will be added for each point.

5.2.12  Tools - Drawing - Symmetric Shapes
This option enables the creation of symmetric shapes. Several base geometry types are available: 

Ellipse

Circle

Polygon

5.2.12.1   Tools - Drawing - Symmetric Shape - Ellipse
This option allows to draw punches with the help of a symmetry base.

1. Select symmetric shape Polygon. 

2. Select free or by radius.

3. If select By Radius, enter radius value.
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5.2.12.2   Tools - Drawing - Symmetric Shape - Circle
This option allows to draw punches with the help of a symmetry base.

1. Select symmetric shape circle. 

2. Enable or disable Mirror

3. Enter axis number.
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4. Draw the punch

5.2.12.3   Tools - Drawing - Symmetric Shape - Polygon
This option allows to draw punches with the help of a symmetry base.

1. Select symmetric shape Polygon. 
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2. Select free or by radius.

3. If select By Radius, enter radius value and sides number.

5.2.13  Tools - Drawing - Grid
This option allow to create a grid and apply punches and markers to it, that can be subsequently
added to a part. This function allows the user to quickly create patterns on parts.

1. Select the Grid option from tools - drawing menu. 

2. Select the points to create the grid. The grid can be created based in three or four point. 

 Draw the first point:  Second point:  And third point:
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The grid will appear, the fourth
point position is automatically
calculated.

To add the fourth point in a
different location, just click in the
desired place.

When the fourth point is added the
grid will adjust to it. 

3. It's possible to click and drag any point to a different location. 

4. In the Tool Option there are available several parameters:
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Line count - Insert the grid, number of rows and columns. 

Add punches - Enable/disable to add punches automatically at the intersection of the grid.

Add markers- Enable/disable to add markers automatically at the intersection of the grid. It's
possible to define the markers Width (mm) and Margin (mm).

In the image bellow is an example:

5. Do a right click and the contextual menu will appear:
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Finish - Select to finish the grid edition.

Cancel - Select to delete the grind and leave the tool. 

Reset - Select to delete the actual grid, and draw other.

Set count - Allow to define the grid number of rows and columns, also available in the tool option
panel. 

Create Markers - Enable/disable to add markers automatically at the intersection of the grid. Also
available in the tool option panel. 

Markers width - Allows to define the markers width, also available in the tool option panel. 

Markers margin - Allows to define the markers margins, also available in the tool option panel. 

Create punches - Enable/disable to add punches automatically at the intersection of the grid. Also
available in the tool option panel.

5.2.14  Tools - Drawing - Continue line
This option lets you add points to the ends of lines.

1. Select the line to be continued.

2. Select Continue Line from the Drawing options of the Tools menu . The cursor will be

displayed as a cross 

3. Add points to the end of the line using the left mouse button.

4. If you want to add points to the other end of the line, use Tools - Change - Reverse to reverse
the direction of the line.
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5.3  Tools - Change
These options let you manipulate the lines that have been drawn.

5.3.1  Tools - Change - Rotate
Use this option to rotate lines.

1. Select the line(s) to be rotated.
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2. Select Rotate from the Change options of the Tools menu   or pressing CTRL+1.

3. Enter the rotation point using the left mouse button.

Use the Space to rotate option to determine which points of the selected lines will be affected

All space (right and left) All the handles will be affected

Right space Only handles to the right of the rotation point
will be affected

Left space Only handles to the left of the rotation point
will be affected

4. Enter another point near the rotation point using the left mouse button, and then move the mouse.

As the mouse is moved, the lines are rotated and the angle of rotation is displayed.

5. Click the left mouse button to finish.
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5.3.2  Tools - Change - Scale
Use this option to scale lines.

1. Select the line(s) to be scaled.

2. Select Scale from the Change options of the Tools menu  or pressing CTRL+2.

3. In the tool option it's possible to choose between Scale Free or By bounding box.

Scale Free

1. Using the left mouse button select a region to scale by clicking on two diagonally opposite
corners.

When you select the second point a number of values will be displayed.

2. Move the mouse to change the scale;
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The values change as follows:

H:1.3313x 10.6329mm - This is the new scale horizontally in this case 33.13% bigger and
10.6329mm longer

V:1.1138x 3.7022mm - This is the new scale vertically in this case 11.38% bigger and 3.7022mm
longer

3. Click the left mouse button to finish.

By bounding box

1. Selecting the option By bounding box, an bounding box is automatically created around the
selected area. 
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2. To edit the scale, you can either change the values displayed in the tool options, length and width
in mm or in percentage Or use the mouse cursor to change the bounding box dimensions by click
and drag in one of the points. 

3. Click the left mouse button to finish.

5.3.3  Tools - Change - Move
Use this option to move lines

Free

1. Select the line(s) to be moved.

2. Select Move from the Change options of the Tools menu  or pressing CTRL+3.

3. Using the left mouse button select the point from which the move operation starts.

4. Move the mouse from the original position to new position. 

 

By Values

1. Select the line(s) to be moved.

2. Select Move from the Change options of the Tools menu.

3. Enter the values (XY, angle and distance).



218 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

 

5.3.4  Tools - Change - Cut Line
Use this option to cut lines.

This is the same as clicking the Cut Line  button in the Tools toolbar or pressing the Home
key.

To cut a line,

1. Select the line to be cut.

2. Select Cut Line from the Change options of the Tools menu. The cursor is displayed on the line.

3. Move the cursor to the required position.

4. Click the left mouse button to cut the line.
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5.3.5  Tools - Change - Break Line By Angle
Use this tool to break the lines points that have an angle inferior to user-defined value. 

1. Select the line to apply the break line by angle tool.

2. Select Break Line By Angle from the Change options of the Tools menu. 

3. A text box will appear, insert the angle and press ENTER key to apply. 

4. The line will break where the angle is equal or higher to the inserted one (in this examples 90º).
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5.3.6  Tools - Change - Trim
Use this option to Trim lines.

This is the same as clicking the Trim  button in the Tools toolbar.

1. Select the main line.

2. Select the Trim option (Tools - Change - Trim).

3. Select the side of a line where the trim will be applied. 

4. The selected side of the line, after the main line, will be erased.

a. To trim several lines at the same time, click and drag to define the trim area and select more
then one line simultaneously. 
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b. Release the right mouse button and the trim will be applied.

5. To finish the trim press enter or do a right click and and select finish from the contextual menu.

Finish - Allows to leave the tool and apply the changes.

Cancel - Allows to close the tool and cancel the changes.

Mode - Allows to select the trim tool mode, between the normal behavior and the reversed.

Trim Normal - The selected side of
the line will the erased.

Trim Reversed - The selected side of
the line will be the one to stay.
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5.3.7  Tools - Change - Trim (Hide)
Use this option to Trim (Hide) lines.

This is the same as clicking the Trim (Hide) button in the Tools toolbar.

1. Select the main line.

2. Select the side of a line where the trim will be applied

3. The other side of the lines after the main line will be hidden.

4. To finish the trim press enter or do a right click and and select finish from the contextual menu.

Finish - Allows to leave the tool and apply the changes.

Cancel - Allows to close the tool and cancel the changes.

Mode - Allows to select the trim tool mode, between the normal behavior and the reversed.

Trim Normal - The selected side of
the line will the hidden.

Trim Reversed - The opposite side of
the line will be the one to be hidden.



223Tools Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

5.3.8  Tools - Change - Hide Part of a Line

Use this option to hide part of a line. The line will still be held in its original state, but parts of the line

can be removed from display.

This is the same as pressing the END key.

To hide part of a line,

1. Select the line to be partly hidden.

2. Select Hide Part of a line from the Change options of the Tools menu. The cursor is displayed
on the line and both ends will be highlighted.

3. Move the cursor to either end and drag it along the line holding down the left mouse button.

The ends of the line will be hidden
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4. In alternative, do a right click over either line ends and select one of the options, Set distance from
source or Set distance from opposite. 

Set distance from source - Insert the distance from the original line point.

Press ok, and the change will be applied. 

If the distance value is 0, the point will return to is original place. 

Set distance from opposite - Insert the distance between the selected point and other line end. 

This value is the distance between the two line ends. Change the distance and press Ok to apply the
changes. 

5. To Finish press the middle mouse button, Esc  or do a right click and select finish from the
contextual menu.
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When the line is selected, all the original line is highlighted. You can use the option again to
restore hidden sections of lines.

5.3.9  Tools - Change - Reverse
Use this option to change the direction of a line.

1. Select the line to be reversed.

2. Select Reverse from the Change options of the Tools menu.

5.3.10  Tools - Change - Extend/Shorten Line
Use this option to extend or shorten a line.

There are two ways to use this tool:

a) By selecting the Line first:

1. Select the line to be extended/shortened.

2. Select Extend/shorten Line from the Change options of the Tools menu .

3. A dialogue box is displayed, it's possible to set the value By size in mm or By percentage. 

To extend the line insert a positive value and click OK.

To shorten the line insert a negative value and click OK.

Both ends of the line will be extended/shortened by the given value.
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b) Selecting the tool first:

1. Select Extend/shorten Line from the Change options of the Tools menu .

2. Do a right click and the contextual menu will appear.

3. Its possible to extend/shorten the line By Value, By percentage or By point. 

a. By Value (shortcut key Q):

- Select the option Set Value from the contextual menu or press V, to define the value in
mm.

A dialogue box is displayed. Insert the value in mm and press Ok.

To extend the line insert a positive value and click OK.

To shorten the line insert a negative value and click OK.

- Place the mouse cursor over one of the line ends and do a left click over to apply the
extension. 

- The tool will remain active, doing more right clicks over the line ends the same change will
be applied.

b. By Percentage (shortcut key W)

- Select the option Set Value from the contextual menu or press V, to define the percentage
value.

A dialogue box is displayed. Insert the percentage value and press Ok.
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To extend the line insert a positive value and click OK.

To shorten the line insert a negative value and click OK.

- Place the mouse cursor over one of the line ends and do a left click over to apply the
extension. 

- This tool will increment x% based in the line length, this means that for every new click the
length incremented will be higher than the previous.

c. By Point (shortcut key E):

- Place the mouse cursor over one of the line ends and do a left click over it to start. 

- The distance is controlled by the mouse cursor. Do other right click to fix the fix extension
position. 

- The tool will remain active, its possible to repeat the process as many times as desired. 

An example of using this option to short the line:

5.3.11  Tools - Change - Explode
Use this option to change a curved line into a polyline (several connected straight segments).

1. Select the line to be exploded.
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2. Select Explode from the Change options of the Tools menu .

5.3.12  Tools - Change - Smooth
Use this option to smooth line.

1. select line.

2. select Smooth from the Change options of the Tools menu .

3. starting over a point on the line, simply redraw the line to get the desired smooth aspect. This tool
allow for line smoothing only on a specific section of the base line or at its full extent.

4. to finalize just press ENTER or right-click and choose the intended action.
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5.3.13  Tools - Change - Filter
Use this option to filter points lines. The number of points in a line can be dramatically reduced with
this command.

1. Select the line to be smoothed.

2. Select Filter from the Change options of the Tools menu .

The line will be highlighted and the Tool Options toolbar will look as follows:

3. Move the slider with the left mouse button.

Clicking the left mouse button will update the menu and highlight the line in its current geometry.

As the slider is moved the number of points in the line, the Max error (maximum distance from the
original line) and the Total error (total distance from the original line) are displayed.

4. Click the middle mouse button to complete the command.

5.3.14  Tools - Change - Join Lines
Use this option to join separate lines into one line.

1. Select Join Lines from the Change options of the Tools menu  or pressing CTRL+J.

The menu will be displayed as a box on the lines
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2. Select the end of the first line to be joined using the left mouse button

3. Select the start of the next line using the left mouse button

The lines will be joined

4. Continue to select other lines to be joined or press the Esc button to finish.

5.3.15  Tools - Change - Join Lines by Distance
Use this tool to join the all the lines that are an user-defined distance from each other.  

1. Select the lines to apply the tool.

2. Select Join Lines by Distance tool from the Change options of the Tools menu. 

3. A text box will appear, insert the distance and press ENTER key to apply. 
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4. All the lines that are an user-defined distance or less, from each other are joined.  

5.3.16  Tools - Change - Swap Lines

Use this option to swap lines. If a line has several dependant lines (for example, mirrors or offsets)

swap line can be used to replace the original line and keep all the dependencies.

1. In the diagram above the selected line has been used to create the other lines (offsets and
mirrors)

2. Draw a new line to carry the dependencies (in black) and select the original line.
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3. Select Swap Lines from the Change options of the Tools menu.

4. Select the new line (in black)

The dependencies are carried onto the new line.

5.3.17  Tools - Change - Bounding Box

Use this option to draw a bounding box around selected lines.

1. Select the line(s) to be used to define the bounding box.

2. Select Bounding Box from the Change options of the Tools menu.

A box will be drawn around the selected lines
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5.3.18  Tools - Change - Center point
This tool allow to create a punch in the center of the selected group of lines. 

1. Select a group of lines.

2. Select the Center point option (Tools - Change - Center point)

3. A punch will appear in the center of the selected lines. 

5.3.19  Tools - Change - Wrap Lines
Use this option to wrap lines around another line. This option is usually used when constructing
moccasin patterns.

1. Select the line(s) to be wrapped. Do a Pre-Copy to keep the original lines position.
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2. Select Wrap Lines from the Change options of the Tools menu .

3. Select the guide line, this line is used as the base line to wrap the other lines around

4. Select the line to wrap around the base line.
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5. The lines will be wrapped.

6. Use the Red pointer to scale the wrapped lines, just click and drag.
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7. A scale length factor (% / mm) could be used to extend or decrease the wrapped lines lengths.

8. Do a right click and select Finish from the contextual menu to apply the changes.

Tip: Learn how to apply punches dependent on other punches. 

Doing a right click several option are available in the contextual menu:
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Finish - Select to apply the changes and close the tool.

Cancel - Select to cancel the changes e close the tool. 

Both directions - The warp lines direction will be for both forward and backward. 

Forward direction - The warp lines direction will be forward. 

Backward direction - The warp lines direction will be backward. 

5.3.20  Tools - Change - Average lines
This tool allow to do a quick modification of two lines to establish a mean plus blend region effect.

1. Select the two lines

2. Go to Tool - Change - Average lines

3. It will appear two new lines between the two selected
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4. It's possible to control the new lines approximation using the handles in it. Just click over it and
drag.

5. When the lines are in the correct possition, do a rigth click and select finish.
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6. The new lines will replace the old ones

Note: To keep the old lines to, you just need to do a pre-copy before start the Average lines
process.

5.3.21  Tools - Change - Spring Adjustment
Semi-automatic springing process allowing for a coordinated rotation and offsetting of parts.

1. To start the springing process, select the part lines to apply the deformation.
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2. Then active the option Spring Adjustment from the Tools - Change menu.

3. Select the center line. 

  

4. Do a right click to open the context menu.
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5. Select the Add path option.

6. Select the line or lines to apply the path.

7. It's possible to select just a part of the line, just keep the left mouse button pressed over the line
and drag, from the start point until the last point you want to select.
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8. Now doing a right click, select the deformation to be applied, from the contextual menu.

Rotate:

Using the left mouse button, click to select the
rotation point.

Move the mouse, select the rotation axis, by doing
a click with the left mouse button.

Then start moving the cursor and the lines will
rotate, the angle of rotation is displayed.

Do left click with the mouse button to stop the
rotation.
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Move:

Using the left mouse button, click in the point from which the move operation starts.

In the Tool Options that point is shown as point 0,0.

Move the mouse cursor and the lines will move.

In the Tool Options you can see the distances from Axis-aligned and Relative to center line.
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In alternative it's possible to change the distance directly in the Tool Option.

9. Doing a right click and the contextual menu will open. 
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Finish - Allows to accept the changes and close the tool.

Cancel - Allows to close the tool and cancel the changes.

Undo - Allows to undo the last change. 

Redo - Allows to redo the last change.

Reset position - Allows to reset the lines position. 

Previous position - Allows to move the lines to the previous position.

Rotate - Allows to rotate the lines.

Move - Allows to move the lines.

Add path - Allows to add a path.

Restart - Allows to restart all the process. Will be asked to select central line. 
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5.3.21.1   Spring Adjustment - Complete process
1. To start the springing process, select the part lines to apply the deformation.

2. With the lines selected, go to Tools - Change and select the option Spring Adjustment.

3. Select the center line (axis). 

4. When selected will appear with a different color. 
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5. Do a right click and select the Add path from the context menu, or press E key. Now select the
line(s) section to apply the path.

6. Do a right click and select the Rotate from the context menu or press R key. Apply the required
rotation.

7. Do a right click and select the Add path from the context menu, or press E key. Now select the
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lines sections to apply the path.

8. Do a right click and select the Rotate from the context menu or press R key. Apply the required
rotation.

9. Do a right click and select the Add path from the context menu, or press E key. Now select the
line section to apply the path.
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10.Do a right click and select the Move from the context menu or press T key. Apply the required
movement.

11. Do a right click and select the Reset Position from the context menu or press 0 key. The
original lines will return to his original position. Do a right click and select the Finish from the
context menu or press ENTER to exit the tool e apply the changes. 
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5.3.22  Tools - Change - Convert
These options allow you to convert lines to sawtooth lines, curves or to axis lines.

5.3.22.1   Tools - Change - Convert - to Sawtooth

Use this option to change the selected line to a sawtooth line .

5.3.22.2   Tools - Change - Convert - to Axis

Use this option to change the selected line to an axis  or pressing CTRL+G.
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5.3.22.3   Tools - Change - Convert - to Curve

Use this option to change the selected line to a curved line .

5.3.22.4   Tools - Change - Convert - to Bezier
Use this option to change the selected line to a Bezier line.

5.3.22.5   Tools - Change - Convert - From Axis to Line
Use this option to change the selected axis to a line or pressing CTRL+G.

5.4  Tools - Measurements
This option let you take measurements on the screen, either in a straight line or along lines, select

Measurements from the tools menu   or press CTRL+K.

5.4.1  Free measurements

1. Select Measurements from the Tools Menu  or pressing CTRL+K. The cursor will be
displayed

2. Move the cursor to the position you want to measure from and press the left mouse button.

3. Move the cursor to the point you want to measure to.
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The measurement is displayed in the menu

4. Click the left mouse button to take another measurement or the Esc button to finish the command.

5.4.2  Measurement along lines

1. Select Measurements from the Tools Menu  or pressing CTRL+K. The cursor is displayed

2. Click the right mouse button to display the following menu

3. Select Mode and another menu is displayed

4. Select Along or press X. The cursor will be displayed

5. Move the cursor close to the line you want to measure. As you get close, the line will highlight.
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6. Click the left mouse button at the point on the line you want to measure from.

7. Move the mouse to the position you want to measure to.

The measurement is displayed in the menu.

8. Click the left mouse button to take another measurement or the Esc button to finish.

5.4.3  Using markers when measuring
When measuring it is possible to leave markers on the points used for taking the measurements.

The following example was also used in the Free measurements section.

To add markers when measuring,

1. enter the first point using the left mouse button, but do not enter the second point using the left
hand mouse button

2. when in the correct position to measure to, click the right mouse button and select Place
Markers

The start, end and mark now points will be left as markers on the shell.
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5.4.4  Measure fixed length
Measuring over a line from a point plus a distance value is possible using the fixed length option.

1. select line to measure.

2. right click and under Measure fixed length select Measure fixed length option.

3. on the Tool Options toolbar, under Mode select Along.
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4. Fixed Length - enable or disable fixed length measuring.

5. enter the Length.

6. Add mark at start - enable or disable the placement of a mark at start of the measured segment.

7. Add mark at end - enable or disable the placement of a mark at the end of the measured
segment.

  

5.5  Tools - Copy Properties
Use this option to copy properties between objects.

1. select the object from which the properties are being copied. 

2. Select Copy Properties from the Tools  toolbar.

3. Press Ctrl and left mouse button to copy all the properties of the object. To select individual
properties press the right mouse button and select the required properties from the menu using the
left mouse button.

The cursor will be displayed   when the properties have been copied.

4. Move the cursor to the objects to have these properties applied to them and press the left mouse
button.
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5.6  Repeat last operation
This tool allows you to retrieval the last used tool. Select Repeat last operation from  the Tools
menu or press F2.

1. Draw a line and select it.

2. Go to Tools - Change - Cut Line and cut de line.

3. After that the cut tool is disable.

4. If you want to used the same tool again press F2 and the tool is turn back on.



Part

VI
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6  Operations Overview
This menu lets you

Create new lines from existing geometry using, the offset, perpendicular and mirror options.

Apply markers and punches to any line.

6.1  Operations - Links On/Off
This option lets you keep a reference to the original line if required.

This is the same as clicking the Links  button in the Tools toolbar

If Links is ON when a line is created by mirroring or offsetting, any future edits of the original line will
also be reflected in the linked lines.

If Links is OFF when an operation is carried out, the newly created line is independent.
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6.2  Operations - Offset
This option allows you to offset lines.

This is the same as clicking the Offset  button in the Tools toolbar or pressing F5.

To set a shortcut for commonly used offsets, including distance and offset type,

1.  Set the Distance, right click on a blank shortcut box at the top of the menu, enter the name for
this kind of offset and select OK

2. This shortcut is now available for future use.

3. More space is available for more quick access buttons by pressing the 4 triangle button.
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6.2.1  Creating an offset to a line
1. Select the line to be offset.

2. Select Offset from the Operations menu. The Tool Options toolbar displays appropriate options.

3. Select the Distance for the offset using one of the following methods:

§ by clicking in the up/down arrows;

§ by typing in a value;

§ dragging the point with the cursor using the left mouse button.

- It's also set the distance point by point, by selecting the point with the left mouse button, then
doing a right click and selecting Distance from the contextual menu or press key D.

Press Enter and the distance will be applied to the selected point.

4. Select the direction of the offset by using the change side button , or pressing S or doing a
right click and select Swap side from the contextual menu.

5. Select the type of offset by selecting an Offset type.
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Approximate and Free - The original points are offset

Correct and Frozen - Extra points are added to the offset to keep the line parallel to the original.

Offset Original Line - Make change to original line instead of creating a new one.

6. If you want a constant offset click the middle mouse button to finish.

7. If you want to add different values at different points, select the points using the left mouse button

Enter a new value or position with the cursor.

8. Repeat for as many points as required

9. To finish click in the middle button or do a right click and select Finish from the context menu.

Finish - Apply the changes and close the tool.

Distance - Set a specific distance to the selected line points.
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Swap side - Change the side of the offset

Clear distance - If the point as applied a manual distance, it release the point and the automatic
distance will be applied.

If a point has applied a manual distance, it will be connected by a line to the main point:

  

To release this constrain, you can either do a right click and select Clear distance from the
contextual menu, or approach the line with the mouse cursor and "Cut the line". When the mouse
cursor is placed over the connector line, will change and appear like a scissors, just do a right click
to release the point. 

 

Select next point - Change the selection to the next line point.

Select previous point - Change the selection to the previous line point.

Configuration - Select one of the configurations for commonly used offsets.

6.2.2  Changing the values of the offset
1. Select the offset line

2. Click the right mouse button and select Change or press F12
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3. Select the point to edit

4. Change values, using one of the methods described in Creating an offset to a line

5. Click the middle mouse button to finish.

6.2.3  Offset - Grading
This option allows control offsets behavior while grading.

1. Select the offset and edit it, by doing a right click and select Change from the contextual menu or
pressing F12 key.

2. Select Grading tab from the tool option.
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3. To Add new grading groups press the button .

4. Insert the minim and the maxim size, and press Ok.

5. The new grading will be added to the list.

6. Now configure a new value for the offset, and it will be applied to the grading rule.
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7. To remove a grading rule, select it and press the button .

6.3  Multiple Offset
This option allows you to multiple offset lines in a single operation.

Number of offsets - Enter the number of offsets.
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Offset type:

Approximate and Free - The original points are offset.

Correct and Frozen - Extra points are added to the offset to keep the line parallel to the original.

Distance - Chose between Fixed, Variable or Mouse Defined.
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6.4  Operations - Perpendicular
This lets you draw a line or axis perpendicular (at 90 degrees) to another line or axis.

6.4.1  Operations - Perpendicular - Line
This lets you construct a line perpendicular to another line.

1. Select the line from which you want to construct the perpendicular line.

2. Select Line from the Perpendicular options of the Operations menu  . The cursor will be
displayed on the line
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3. Move the cursor to a position which gives the correct start point for the line and the correct
distance from the line.

4. Press the left mouse button to create the line. Its possible to create several lines. 

5. Do a right click and several options are available in the contextual menu.
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Finish - This option applies the changes and close the tool.

Cancel - This option cancel the changes and close the tool.

Both sides - If this option is active, the perpendicular will be applied in both sides of the line.

 

Set Distance - Insert the perpendicular line length.

Automatic distance - The distance is controlled by the mouse position. 

Note: The perpendicular will be dependent from the master line. To break the dependency to the
master line go to Operations - Release.
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6.4.2  Operations - Perpendicular - Axis
This lets you construct perpendicular to another line.

1. Select the line from which you want to construct the perpendicular axis.

2. Select Axis from the Perpendicular options of the Operations Menu . The cursor will be
displayed on the line

3. Move the cursor to a position which gives the correct start point for the axis and the correct
distance from the line.

4. Press the left mouse button to create the axis. Its possible to create several axis. 

5. Do a right click and several options are available in the contextual menu.
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Finish - This option applies the changes and close the tool.

Cancel - This option cancel the changes and close the tool.

Both sides - If this option is active, the perpendicular will be applied in both sides of the line.

 

Set Distance - Insert the perpendicular axis length.

Automatic distance - The distance is controlled by the mouse position. 

Note: The perpendicular will be dependent from the master line. To break the dependency to the
master line go to Operations - Release.
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6.4.3  Operations - Perpendicular - Circle
This lets you construct perpendicular to another line.

1. Select the line from which you want to construct the perpendicular circle.

2. Select Circle from the Perpendicular options of the Operations Menu. The cursor will be
displayed on the line

1. Move the cursor to a position which gives the correct start point for the circle and the correct
distance from the line.

2. Press the left mouse button to create the circle. Its possible to create several circles. 

5. Do a right click and several options are available in the contextual menu.
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Finish - This option applies the changes and close the tool.

Cancel - This option cancel the changes and close the tool.

Set Distance - Insert the circle diameter.

Automatic distance - The diameter is controlled by the mouse position. 

Note: The perpendicular will be dependent from the master line. To break the dependency to the
master line go to Operations - Release.

6.5  Operations - Mirror
This lets you mirror or reflect lines about an axis.

6.5.1  Operations - Mirror - Activate Axis
To mirror any lines you must have an active axis. This option activates an axis, making it the current
axis.

1. Select an axis.

2. Select Activate Axis from the Mirror options of the Operations menu . The axis will be
highlighted and displayed as a dotted line.

This is the same as pressing Ctrl+E
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6.5.2  Operations - Mirror - About axis
This mirrors any selected lines about the activated axis.

1. Select line(s) to be mirrored.

2. Select Mirror - To the other side from the Operations menu.

This is the same as clicking the Mirror button  in the Tools toolbar or pressing CTRL+M.

6.6  Operations - Markers
This lets you draw markers over existing lines. Markers are small closed lines or bubbles that can be

added to parts later. Selecting this option  is the same as pressing F6.

1. Select the line to have markers applied.

2. Select Markers from the Operations menu.

3. Define the markers with pairs of clicks using the left mouse button.

The Tool Options toolbar displays appropriate options.
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4. Use the options in the upper portion of the toolbar to adjust the size and position of your markers.

   - Width

   - Distance to line

   - Side (or pressing S)

   - Side indicator size

   - On Section ( initial margin and final margin)

   - Automatic (max. length and gap)

5. Press the middle mouse button to complete the command.

To set a shortcut for commonly used Markers, including width, distance to line, side and others
values,

1. Click on a blank shortcut box at the top of the menu
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2. Type in a name and select OK. This shortcut is now available for future use.
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3. more space is available for more quick access buttons by pressing the 4 triangles button.

6.7  Operations - Punches
This lets you space punches on lines and offset from them. Selecting this option is the same as
pressing F9.

1. Select the line to apply the punches.



278 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

2. Select Punches from the Operations menu  . The Tool Options toolbar displays appropriate
options.

Using the options on the toolbar, select the way the punches should be applied:

By number - Equally space the input number of punches along the line

By distance - Space punches at the specified distance along the line.

Start and End distance - Place a punch at an input distance from the start and end of the
line. This options are available when the By distance option is used.

Dependent on other punches - Copy the number of punches from another punch line; The number
of punches will always be the same even when graded.
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Distance to master line - Offsets the punches parallel to the line (use the arrows to swap the offset
to the other side or press S)

Start Margin - Distance from the start of the line to place the first punch.

End Margin - Distance from the end of the line to place the last punch.

Manual - If ON, the punches can be edited manually after they have been applied to the line

Automatic - If ON, the values defined in other options are used to space the punches

Align directions / Rotation - If ON, align the punches to the geometry of the line. If OFF, apply the
punches in their original XY positions. Or enter rotation value.

On section - If ON, the punches are placed on a section of a line. The section is defined by
selecting two lines that intersect the line.

On intersection - If ON, one punch is placed on an intersection. Use the cursor to select the
intersecting line.

Oblique on intersection - If ON, one punch is placed oblique to an intersection. Use the cursor to
select the intersecting line.

Number of lines - Enter the number of punch lines.

Line Separation - Distance between lines.

Final Line Separation - Distance between final lines. 

Start Scale - Insert the first punch size. The punches in between will scale based in the start and
end scale size.  

End Scale - Insert the last punch size. The punches in between will scale based in the start and end
scale size.  

Mirror distribution -This option is available when the Distance to master line is being used. If this
option is active the punches will be mirrored to the other side of the line.

Shape - The software is supplied with two standard punch shapes, a cross and a circle. By default
the punched are drawn as crosses. 

 - Select to transform the punch shape into a cross.

- Select to transform the punch form into a circle, as you select this option, a text box will
appear to insert the Circle Radius; 

 - Insert the Circle Radius and press Enter to
apply.

- Select to access the Punch Generator Window. 

3. Click the middle mouse button to finish



280 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

To edit the spacing of the punches,

1. Select the punches

2. Click the right mouse button

3. Select Change or press F12

To set a shortcut for commonly used Punches, including punches type (by number, by distance or
dependent on other punches), distance to master line, start margin, end margin, on section, on
intersection or oblique on intersection.

1. Right click on a blank shortcut box at the top of the toolbar.

2. The contextual menu will appear, select configure.

3. Type in a name and select OK.
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4. Type shortcut key and select OK.

5. This shortcut is now available for future use.
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6. More space is available for more quick access buttons by pressing the 4 triangles button.
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6.7.1  Punch Generator
The punch generator is available in the Punches distribution Tool Options.

Select the Punch Generator  button and the Generate punch window will appear.
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 - Press to start creating a new punch.

- Press to open a punch file. 

- Press to save the punch to file. 

1. To start a new punch creation, select the punch Type:

2. As you select the Type, a preview will be visible
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3. Set the available parameters for the selected punch type. 

4. Insert as many Types as required. 

5. To easily identify witch type is shown in the preview, just move the mouse cursor over the preview
and the Type and parameters will be highlighted.
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6. The opposite is also applied, clique over the Type and the preview will be highlighted.

7. When finished, press Ok and the punch will be applied. 

6.7.2  Add/Delete Punch Shapes from the library
The software is supplied with two standard punch shapes:

a cross

a circle.

You can add any new shape of punch to the library.

1. Draw a new punch shape

2. Select the lines



288 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

3. Select the Punches tab of the Parts/Library toolbar.

4. Click Add.

A dialogue box is displayed

5. Type in the name for the new punch shape and click OK. The new punch will be displayed ready
for selection

To delete a punch shape from the library:

1. Select the punch shape from the Punches tab of the Parts/Library toolbar.

2. Click in the Remove button.

3. A confirmation message appear, select Yes to delete the punch or No to cancel.  

6.7.3  Punches Grading Behav iour
This option allows control punch behavior while grading.

1. Select the punches. And edit them, by doing a right click and select Change from the contextual
menu or pressing F12 key.
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2. Select Grading tab.

3. Press Add button to add the necessary grading groups, in this case, the one from 35 to 38 has 3
punches and the one from 39 to 42 has 4 punches. Finalize pressing the Enter key.

4. Press Remove button to delete grading groups.
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6.7.4  Punches dependent on other punches
This allows to copy the number of punches from another punch line; use the cursor to select the line.

1. Select the line to apply the punches.

2. Select Punches from the Operation menu or press F9. The last punch configuration used will be
automatically applied to the line.



291Operations Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

3. From the option Dependent on other punches from the Tool Option.

4. Select the master punches.
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5. The new punches will be automatically rearranged based on the masters.
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If the masters change, the dependent will follow. 

Note: Usually the punches applied to the tongue are set by distance, then the punches applied to
the vamp are dependent to the tongue punches.

6.7.5  Multiple Punch Lines
This option allows creating many punch lines.

1. Draw the line, select the line and the desired type of punches.

2. Go to operation menu and select punches.
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3. The next tool box will be displayed.

4. Change the option Number of lines and use the option Line separation to adjust the lines
distance.
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5. The result will be: 

6.7.6  Punches over sawtooth
When a sawtooth is created over a line, its possible to add punches, those will be synchronized with
the sawtooth.

1. Create a sawtooth over line.

2. With the sawtooth selected, go to Punches from the Operations menu   or press F9.

3. It's possible to rearrange the Punches distribution, on the tool options.
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4. Use the Sawtooth position slide bar to change the punches position, based on the sawtooth. 

5. Its also possible to center the punches, increasing the distance from master line.
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6. Now if you change the sawtooth properties, the punches will follow.

In the example was changes the option sawtooth by number property, from 8 to 3.

6.7.7  Editing Punches Distribution
1. Select the punch distribution 

2. In the tool option is now visible the punches Properties.

3. It's possible to insert a name, change the colour, the style, the layer and assign one or more
properties, to add new property  go to Preferences, Default Properties tab.

6.8  Operations - Notches
This toll is used to create or change a notches line.

To create a new notches line:

1. Select the line that will be the master of the notches.
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2. Select Notches from the Operations menu. The notches will be applied.

3. In the tool option are several options available.
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4. To finish, press Enter or do a right click and select Finish from the contextual menu.
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To change notches position (one by one):

1. Select the notches.

2. Click over the notch and drag him.

6.9  Operations - Corner
Use this option to create a corner. This is mainly to control the corners shape of parts.

1. Select the lines, when you select the last line, the corner will be created.

2. In the Tool Options there are available several parameters:
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Type - Select the corner type between Arc, Bezier, Chamfer or Smooth

Radius - Input radius for the first line in mm.

Radius 2 - Input radius for the second line in mm.

Smooth - If the selected type of corner is Smooth, select the smooth factor.

Trim masters - Enable\Disable the trim masters option.

3. To finish press Enter or right click and select finish from the contextual menu.

6.9.1  Corner - Grading
This option allows control corners behavior while grading.

1. Select the corner and edit it, by doing a right click and select Change from the contextual menu
or pressing F12 key.
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2. Select Grading tab from the tool option.

3. To Add new grading groups press the button .

4. Insert the minim and the maxim size, and press Ok.

5. The new grading will be added to the list.

6. Now configure a new value for the corner, and it will be applied to the grading rule.
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7. To remove a grading rule, select it and press the button .

6.10  Operations - Distance Dependence
This tool control line position based on extracted length property from other elements. 

1. Select Distance Dependence tool from  the Operations menu.
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Note: If the tool is not available please deselect the lines.

2.  To create a distance line dependence based on a value inserted manually, select the first option
(Distance) on the Tool options introduce the distance (mm) in the text box.

3. Select the master line (the created line will be equal to this one).

4. Select the base line. (the new line will appear X mm away from the master line, following the base
line)

5. The new line (green line) it was created 50mm from the master line.

6. To create a distance line dependence based on the length of other line, select the option
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Dependent from the Tool options.

7. Select the master line.

8. Select the base line.

9. Select the line to measure distance.

10. If we increment the "line to measure distance", the distance between the green line and the
master line will be automatically readjusted.

11.To create a distance line dependence based on a section, select the option Dependent from the
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Section.

12.Select the master line.

13.Select the base line.

14.Select the line to measure distance.

15.Select the first section delimiter.
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16.Select the second section delimiter.

17. The new section is created equal to the main section, if the main section is changed, the new
section will be readjusted, to ensure that the both sections have exactly the same length.
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6.10.1  Distance Dependence - Grading
This option allows control distance dependence lines behavior while grading.

1. Select the distance dependence line. And edit them, by doing a right click and select Change
from the contextual menu or pressing F12 key.

2. Select Grading tab from the tool option.
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3. To Add new grading groups press the button .

4. Insert the minim and the maxim size, and press Ok.

5. The new grading will be added to the list.

6. Now configure a new value for the dependence line, and it will be applied to the grading rule.

7. To remove a grading rule, select it and press the button .
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6.11  Operations - Stitch l ine
This tool allows automatic insertion of corners while stitching multiple lines to ensure smooth
transitions.

1. To create a Stitch line, active the Stitch line option from the menu Operations. 

2. Select the lines to stitch together. One click over each line successively. 

3. Select finish from the contextual menu.

Finish - Allows to finish the stitch line.

Cancel - Allows to cancel the stitch line. 

Remove Last Pt - Allows to remove the added last point. 

Chamfer on next - Select this option to apply the type of corner Chamfer in the intersection
between the selected line and the next selected line. 

Select the first line and active
the Chamfer on next option,
from the contextual menu or
pressing letter C in the keyboard.

Insert the Radius(before),
press Enter, then insert the 
Radius (after) and press Enter
again.

Select the other line and the
corner will be created with the
selected radius.
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Bezier on next - Select this option to apply the type of corner Bezier in the intersection between
the selected line and the next selected line. 

Select the first line and active
the Bezier on next option, from
the contextual menu or pressing
letter B in the keyboard.

Insert the Radius(before),
press Enter, then insert the 
Radius (after) and press Enter
again.

Select the other line and the
corner will be created with the
selected radius.

Arc on next - Select this option to apply the type of corner Arc in the intersection between the
selected line and the next selected line. 

Select the first line and active
the Arc on next option, from the
contextual menu or pressing
letter A in the keyboard.

Insert the Radius and press
Enter.

Select the other line and the
corner will be created with the
selected radius.

6.12  Operations - Bisection
This option allows you to construct a lines that bisects two other lines.

1. Select the lines.

2. Select Bisection from the Operations menu.

3. Insert the number of lines and click OK.
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4. The lines will be created

5.  Select one line, do a right click and select Change

6. Now its possible to add new parameters to the line and change is position.
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7. To add a new parameter press Shift, and do a left click over the desired place.

8. It's possible to change the parameter and is position by draging the red points over the lines
(middle red point to change position, top red point to change parameter), or by change the values
in the Tool Options.
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6.13  Operations - Anchor
This option creates a link between lines of different geometry; it also holds them constant relative to
each other when graded.

1. Select the anchor line.

2. Select Anchor from the Operations menu.

3. Select the master line

The anchor line turns yellow. Any edits done to the master line are reflected in the anchor line

4. The lines will remain a constant distance apart when graded (the length will grade).

6.14  Operations - Release
This option breaks the dependency to a master line.

1. Select dependent line(s).

2. Select Release from the Operations menu  . Any dependency to a master line is broken.
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6.15  Operations - Release All
This option breaks the dependency to a master line and lines dependent from the current line.

1. Select dependent line(s).

2. Select Release All from the Operations menu. Any dependency to a master line or slave lines
are broken.





Part

VII
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7  Parts Overview
This menu lets you create parts and add holes, punches and generally edit parts.

7.1  Parts - Create Part
This menu lets you to choose between create a part by contour or by on click.

Note:Enhanced part collection tool with information about last collected parts. 
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7.1.1  Parts - Create Part - By Contour

This is the same as clicking the Create Part  button on the Parts toolbar or pressing Ctrl+T

Parts can be created very quickly using hot keys and menu options.

Treatments (for example, overlaps, folds and seams) can be added during part creation.

If you work on a folded shell, centre notches can be added automatically.

Inside indicators can be applied automatically.

The software is designed to have some built in intelligence. So, if a treatment is applied to one
side of a folded part that joins the other side of the part, the other side will have the same
treatment applied to it.

The following examples show you how to create some of the common types of parts.

Creating a part with no treatments or folds

Creating an unfolded mirrored part

Creating an unfolded non-mirrored part

Creating parts with treatments

Tips and Tricks
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7.1.1.1   Creating a part with no treatments or folds
1. Select By contour from Create Part in the Parts menu.

2. Start to define the boundary of the part using the left mouse button.

3. Continue to select lines going in the same direction. The direction is not important as long as
within each part you move in the same direction.
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4. Click the right mouse button to display the following menu.
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5. Select Finish to complete the part. The part can also be finished by pressing the Enter key or
clicking the middle mouse button.

The part will be highlighted.

Remove Last - If you make a mistake when selecting a line, use this option to undo the last
selection. You can then pick  another line.

6. The part will be added to the Parts/Library Bar. 
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Note:The part will always go to the first empty space in the parts toolbar.

7.1.1.2   Creating an unfolded mirrored part (1 axis)
1. Select By contour from Create Part in the Parts menu.

2. start to define the boundary of the part using the left mouse button. Select the first line next to the
current axis that will be used to unfold the part.

3. continue to select lines going in the same direction.
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4. click the right mouse button to display the following menu.
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5. select Finish (close part with reflection) to complete the part. The part will be highlighted.

7.1.1.3   Creating an unfolded mirrored part (2 axis)
Example in how to create an unfolded mirrored part with two axis. 

1. Select By contour from Create Part in the Parts menu.

2. Start to define the boundary of the part using the left mouse button. Select the first line next to the
current axis that will be used to unfold the part.
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3. Continue to select lines going in the same direction.

4. Click in the right mouse button to display the contextual menu. And select the option Switch
Side. 
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5. Continue to select lines going for the other side.

6. Place the cursor over second axis and press CTRL+E to active it.



328 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

7. Click the right mouse button to display the following menu.

8. Continue to select lines going for the other side.
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9. Place the cursor over the other axis and press CTRL+E to active it.
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10.Click the right mouse button to display the following menu.

11.Continue to select lines going for the other side.
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12.Click the right mouse button to display the contextual menu.

13.Select Finish to complete the part. The part will be highlighted.
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7.1.1.4   Creating an unfolded non-mirrored part
1. Select By contour from Create Part in the Parts menu.

2. Start to define the boundary of the part using the left mouse button. Select the first line next to the
current axis which will be used to unfold the part.

3. Continue to select lines going in the same direction.
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4. Use the right mouse button to display this context menu and select Switch Side
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(Tip: If you press the Ctrl key when selecting the next point you do not need to select Switch Side
from the menu.)

Now you can pick the other side of the part (in reverse order).

5. Continue picking the boundary
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6. Click the right mouse button to display the following context menu.
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7. Click Finish to complete the part. The part can also be finished by pressing the Enter key or
clicking the middle mouse button.

The part will be highlighted.
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7.1.1.5   Creating parts with treatments
1. Select By contour from Create Part in the Parts menu.

2. click the right mouse button when in the graphics window and select Fold on next

This is the same as pressings the hot key F

3. start to define the boundary of the part using the left mouse button.

4. before selecting the next line, click the right mouse button and select Overlap on next
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This is the same as pressing the hot key O

5. select the next line.

6. select the gross feather edge. If you don't select a treatment, no offset or corner will be applied
(The default is zero offset and an ordinary corner).
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7. before selecting the heel curve click the right mouse button and select Seam on next

This is the same as pressing hot key S
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8. click the right mouse button to display the following menu.

9. click Finish to complete the part. The part can also be finished by pressing the Enter key or
clicking the middle mouse button.

The part will be highlighted.
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7.1.1.6   Creating parts with two axes (enabling one at a time)
1. Select and active the first axis. To do that you can go to Operations - Mirror - Active Axis or

press CTRL+E, after Axis selection.

Select By contour from Create Part in the Parts menu. 

2. Press the right mouse button and select the option Switch Side.
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3. Start to define the boundary of the part using the left mouse button. Select the lines based on the
numbers order shown in the image below (1,2 and 3).

Press the right mouse button and select again the option Switch Side.

4. Select the top line (marked on the below image with the number 1); next, select and active the
seconde axis. To do so, you can select Operations - Mirror - Active Axis or press CTRL+E,
after Axis selection.
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Press the right mouse button and select the option Switch Side.

5. Continue to select lines, based on the numbers order, as shown in the image below (1,2 and 3).

Press the right mouse button and select the option Switch Side.
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6. Continue to select lines this time the bottom line (marked on the below image with the number 1) .

Click the right mouse button to display the following menu.

7.  Select Finish to complete the part. The part can also be finished by pressing the Enter key or
clicking the middle mouse button.
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7.1.1.7   Creating parts with two axes (enabling the two axes at once)
1. Select the two axes. To select the both axes simultaneously select the first one and keep the 

CTRL press until select the second one.

Activate the axes. To activate the axes you can go to Operations - Mirror - Active Axis or press
CTRL+E, after Axes selection.
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Select By contour from Create Part in the Parts menu. 

2. Press the right mouse button and select the option Switch Side.

3. Start to define the boundary of the part using the left mouse button. Select the lines based on the
red numbers order shown in the image below (1,2 and 3).
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Press the right mouse button and select again the option Switch Side.

4. Continue to select lines based on the red numbers order shown in the image below (1,2 and 3).
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Click the right mouse button to display the following menu.

5. Select Finish to complete the part. The part can also be finished by pressing the Enter key or
clicking the middle mouse button.
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Note: The difference between this method and create a mirrored part is the fact that the lines can be
different on each side. Take the below image for example.
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7.1.1.8   Tips and tr icks
Inside indicators

Shells that have been exported from 3D Design & Engineering - each time you select the
inside feather line (net or gross), an inside indicator will be applied at the point you select the
line.

Digitised shell - For an inside indicator, use the Inside indicator on next option or press M.

If you are trying to create unfolded or mirrored parts and the parts are not being displayed, always
check that the correct axis is selected.

Mirrored or unfolded parts will automatically update if you move the axis.

Lines don't need to intersect a part to be created. The gap between the lines can be up to 25 mm.

Avoid split lines after parts creation. 

7.1.2  Parts - Create Part - By One Click
1. Select By One Click from Create Part in the Parts menu.

2. Position the mouse cursor in the middle of the lines that will compose the part.

3. When the cursor is in the right position, do a click with the left button, the parts contour will be
selected.
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4. Before ending the process you can select more parts; just position the cursor again in the middle
of the desired lines.

When the cursor is in position, do a click with the left button; the parts contour will be selected.
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To end the process, do a right click and select finish or press ENTER. The part will be created.

7.1.3  Editing Parts

7.1.3.1   Editing Parts - Corners
1. Select one or more parts from the Parts/Library toolbar using the left mouse button.

The part will be displayed.
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Using the left mouse button click inside the part, which will be highlighted.

As you move the cursor close to the corner positions (shown by green dots), the cursor will change
to the corner cursor.

Using the left mouse button select the corner, which will be highlighted.
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Select the type of corner from the Tool Options toolbar.

 No corner - Intersect the lines only

 Arc - Insert an arc of given radius

 Bezier - Similar to an arc, but with better results on sharp intersections.

 Chamfer - Cut the corner off with a straight line. If Link button is OFF, you can enter a Begin
and End radius.

 becomes active   when there are treatments on both sides of the corner. If applied, the
net intersection of the two original lines is used to generate an internal cut out. This command is
usually used when one of the treatments is a fold. Control of the radius value is also possible.
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 Smooth - It's possible to adjust the smooth factor, when this corner type is selected the text

box is enable .

7.1.3.1.1  Editing Parts - Treatments

1. select one or more parts from the Parts/Library toolbar using the left mouse button.

The part will be displayed.

using the left mouse button click inside the part. It will highlight. Corners are represented by green
dots.



356 MindCAD 2D Design & Engineering

© 2016 M ind - Software Multimedia e Indus tr ial , SA

As you move the cursor close to the edge the cursor will change to the treatments cursor.

click the left mouse button to select the outline of the part between the corners.

The section of the outline will highlight

2. select the required treatment from the Tool Options toolbar or press the appropriate hot key to
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change the treatment.

7.1.3.1.2  Editing Parts - Radius

This option allows to force smooth corners on treatments.

To force the smooth sharp angle shown in the image below:
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1. Using the left mouse button click inside the part. It will highlight.

2. As you move the cursor close to the edge the cursor will change to the treatments cursor.

3. Click the left mouse button to select the outline of the part.The section of the outline will highlight
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4. In the Tool Options toolbar change the value of the Radius(mm).

5. As you increase the value the sharp angle is smoothed.
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7.1.3.2   Editing Parts - Notches
select one or more parts from the Parts/Library toolbar using the left mouse button.

The part will be displayed.

using the left mouse button click inside the part. It will highlight.
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with the Shift key pressed place the notch on the desired location clicking the left mouse button.

The section of the outline will highlight

select the Notches tab of the Tool options toolbar
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Use the Notches options to set the notch type, size and side.

1. Line - A line placed at the cursor position. You can also enter a Depth and Curvature value.

The notches placement can be on mouse selection.

Or On Intersection than can be Oblique or not.

Oblique OFF Oblique ON

Oblique - A notch with the base of the triangle placed on the line it is created from. Oblique notches
can only be applied using the intersection option.

2. Triangle - A triangular notch, placed with its centre at the position or intersection selected.

The notches placement can be done on mouse selection.
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Or On Intersection than can be Oblique or not.

Oblique OFF Oblique ON

3. Arc - An arc shape - normally used as an inside indicator

The notches placement can be done on mouse selection.

Or On Intersection.

4. Rectangle - A rectangle of given size.

The notches placement can be done on mouse selection.

Or On Intersection.
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move the cursor towards the selected part of the outline. As you get close, the cursor will change
to the notch cursor

position the notch and click the left mouse button.

The notch will be added.

If the cursor is positioned inside the part, the notch will go inwards,

If positioned outside the part, the notch will go outwards.

If the intersection option is used when positioning a notch, the notch cursor will only be
displayed at positions where lines intersect.
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To edit notches,

1. Select them with the left mouse button

2. Use the Tool Options to make the required changes. You can use the Delete key to remove the
notch

To set a shortcut for commonly used notches, including type and value,

1. Click on a blank shortcut box at the top of the menu

2. Type in a name and select OK. This shortcut is now available for future use.
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7.1.3.3   Editing Parts - Text
1. Select the part(s) from the Parts/Library toolbar using the left mouse button. The part will be

displayed with its default text

2. Select the text using the left mouse button.

3. Change the text using one of the following methods

- To rotate the text,

(a) Move the cursor to the yellow dot;

(b) Click the left mouse button and drag the cursor to the required position;

(c) Release the left mouse button.

To drag the text,
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(a) Move the cursor over the text;

(b) Click the left mouse button and drag the cursor to the required position;

(c) Release the left mouse button.

Note:If the text is dragged to one of the part edges, its orientation will adjust automatically. 

To scale the text,

(a) Move the cursor over one of the white dots displayed;

(b) Click the left mouse button and drag the cursor to the required position;

(c) Release the left mouse button.

To add new text to parts,

(a) With the part is selected select the Text tab of the Tool Options toolbar
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(b) Press the button "+". Now select the required text from the list. Press Ok to apply it to the
current part.

7.1.3.4   Editing Parts - Configuring Treatments

Treatments are a quick way of applying offsets, corners and notches in one operation.

There are many options that can be set. You can also add a shortcut that allows them all to be

applied in one operation.

1. Select a part
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2. Select a part of the outline and go to the Treatments tab of the Tool Options toolbar. 

3. Set the Offset type and use the Treatment options to set the treatments.

None - No offset;

Line - A normal offset line;

Sawtooth - An offset with a sawtooth edge.

To set a shortcut for commonly used treatments. Define treatments properties, including offset type,
offset distance, stencil, punch, corner and notches,

1. Set the values on the Offset tabulator

2. Set the values on the Stencil tabulator
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3. Set the values on the Punch tabulator
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4. Set the values on the Corner tabulator
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5. Set the values on the Notches tabulator

 

6. Set the values on the Stretch tabulator
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7. Right click on a blank shortcut box at the top of the toolbar.

8. The contextual menu will appear, select configure.
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9. Type in a name and select OK.

9. Type shortcut key and select OK.

  

10. This shortcut is now available for future use.



375Parts Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

  

11. More space is available for more quick access buttons by pressing the 4 triangles button.
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7.1.3.5   Editing Parts - Stretch
Stretch compensation emulates part controlled deformation that is intended to be off the last. This
includes extreme wrinkle effects.

1. select a part

2. select an edge the part and go to the Treatments tab of the Tool Options toolbar. 

3. set the values on the Stretch tabulator
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Stretch (%) Stretch percentage. This value controls the amount of added material
along the selected edge that should exist to compensate the wrinkle
effect

Start decay distance (mm) Start value distance. This value controls the beginning of the
blending region.

End decay distance (mm) End value distance. This value controls the end of the blending
region.

Taking the following example, where a strap is to be appear with a wave effect, emulating for
example, an elastic material
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with the given parameters on the depicted Stretch tabulator, the part will be compensated like this

    



379Parts Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

7.1.3.6   Treatments - Line Offset
These are the options for the most typical treatment, which is the Line type

Stencil

Stencils are the same as markers; the stencil menu can be scrolled by holding down the left mouse

button.

None - no markers;

Net - Markers that are drawn over the original line;

If Net stencils are used, more information is required;

Width (mm) - the width of the stencil in millimeters;

Margin (mm) - the distance from the next portion of the part outline. This is used to undercut the
markers so they do not break the edge of the part;

Max length (mm) - the maximum length of the marker in millimeters;

Gap (mm) - the gap between markers in millimeters;
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Offset - markers which are offset from the original line. If Offset is used, the following values must be
specified;

Inside - Offset is towards the inside of the part (away from the edge);

Outside - Offset is towards the outside of the part (towards the edge);

Distance (mm) - Distance of the offset in millimeters;

Side indicator - Enter value of the side indicator.

Corner

Corners will be applied at both ends of the treatment.

Notches

Notches will be applied at both ends of the treatment if selected

Offset

The offset from the original line in mm.
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7.1.3.7   Treatments - Corners-Side
It is possible to control the corners of a treatment

Corners - please refer to Editing Parts - Corners for details.

Side Indicator - Enables the side indicator. This option is only available in part creation. 

7.1.3.8   Treatments - Sawtooth offset
These are the options for the Sawtooth type treatment

Triangular - Triangular shape

Rectangular - Rectangular shape

Elipse - Elipse shape

Arc - Arc shape
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User defined - User defined shape. This must be selected from the Punches tab of the Parts/

Library menu

The number of shapes on the part can be defined by

By Length - Length of each shape

By Number Waves - Number of shapes required

Depth (mm) - Depth of the shape in mm

Rounded - Corners of the shapes can be rounded

7.1.3.9   Editing Parts - Names, Cut Groups, Cost Groups and Colours
1. with a part selected, select to the Properties tab of the Tool Options toolbar

2. Change or add the properties.

- Name - Select the part name from the drop down list

- Group - Select the part group from the drop down list. Using the + button will allow you to add
names and groups using the properties options.
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- Color - Define the part color;

- Quality - Part quality used to calculate its cost;

- Properties - It is recommended that this option is unchanged;

- Symmetric - If ON, the part needs to be cut twice (once mirrored);

- Quantity - Number of parts in the project

- Quantity (symmetric) - Number of parts symmetric in the project.

- Side - Left or right.

7.1.3.10   Editing Parts - Points
Entry Point - To define the cutting start position.

Orientation - To define the orientation of the part when cutting. This orientation is used by the
automatic or interactive nesting algorithms.

Code Point - To define the code position which has the option of being inverted (outside or inside).

1. When you select the part the entry point it's already placed. To move the point just click over it
and drag.
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2. To set the orientation point do right click and select the option Show orientation. The orientation
will also be visible in the parts bar. 

3. To add code points, select the part and the line desired.
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a. Do a right click over the place you want to add the point, and select the options Code - Add

b. To delete a code point, select the point, do a right click and select the options Code - Delete

1. With the code point selected, the Code tab will appear in the Tool Options toolbar.
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Note: If you move the part the points will be dragged with it.

7.1.3.11   Editing Parts - Breaking the part boundary.
The boundary of a part can be broken or cut where a line intersects it.

1. select the section of the part boundary you wish to break. This may be for a change in offset
within that section.
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2. Press Shift and move the cursor towards the line that defines the cut position. The cut cursor will

be displayed 

3. click the left mouse button to cut the boundary.

4. apply different treatment to one section.

7.1.3.12   Editing Parts - Edit lines
Sometimes it is useful to be able to display only the lines that are used in the current part. This is
particularly useful when a shell has many lines.

1. Select the part(s) in the parts library.

2. Right mouse click over the part in the Parts toolbar.

3. Select Edit Lines option, from the contextual menu.
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The part and its lines will be displayed for editing

7.1.3.13   Editing Parts - Copy and paste
To make a copy of a part,

1. Select the part.

2. Right mouse click over the part in the Parts toolbar.

3. Select Copy from the contextual menu.
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4. Select a blank space in the Parts toolbar

Click the right mouse button while the cursor is over the blank space.

5. Select Paste All from the contextual menu.
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The copy of the part will be displayed in the parts toolbar.

7.1.3.14   Editing Parts - Return to Shell
Use this option to show all the lines on a part. The display is scaled so that the whole part is shown
on the screen.

With the part selected,

Right mouse click over the part in the Parts toolbar.

1. Select Return to Shell option.



391Parts Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

The part and all lines will be scaled to fit the screen and displayed
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7.1.3.15   Editing Parts - Variants
By default, all the parts included in a model, will scale base in the same grading.

If the grading isn't equal to all the parts, then its possible to define a different grading. 

1. In the Parts toolbar, do a right mouse click over the part to add the different grading.

2. Select Variants option, there are two types of variants, empty or from graded size. 
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7.1.3.15.1  Editing Parts - Variants - New (empty) 

1. In the Parts toolbar, do a right mouse click over the part to add the different grading.

2. Select New (empty), under the Variants option.

3. Now, create the new part to grade. 

4. The new part will be added to the same place in the parts tool bar.
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5. To define the grading for each part size, in the Parts toolbar, do a right mouse click over the part
and select Properties. 

6. Open the second Properties tab, to configure the variants, by size range.
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7. Select the Variant, by default they will be attributed to all sizes. 

8. But as you selected the variant, the correspondent will be active.
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9. With the required variant selected, select the Size Rule.

Note: The Variant Name will assume the Size Range. 

10.Select the other Variant.
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11.Select the Size Rule. 

12. Now there are two different variants, the first part will be used in gradings for size 32 to 33,35,
and the other for size 34 to 36.  

It's possible to add as many variants are desired. For further information go to Parts Properties -
Properties 
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7.1.3.15.2  Editing Parts - Variants - New (from graded size) 

1. In the Parts toolbar, do a right mouse click over the part to add the different grading.

2. Select New (from graded size), under the Variants option.

3. The Place Part window will appear. 

Size - Choose the desired graded size, from the drop down list.

Min - The smaller graded size will be selected

Model - The model graded size will be selected

Max - The bigger graded size will be selected

All - All sizes will be selected
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Advanced - Opens the part selection window, and allows to select, one, several or all graded sizes.

4. Select the desired graded size(s) and press Ok, now its possible to change the part geometry
only for the selected graded size(s).

5. The change is only applied for the selected graded size. 

6. The other sizes remain as they were.
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7.1.3.16   Editing Parts - Simulate Cut
This option simulate cut the parts.

1. Select the part(s).

2. Right mouse click over the part in the Parts toolbar.

3. Select Simulate Cut from the contextual menu.
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 4. Select exporter machine and size to simulate.

 5. The Cut simulation window will appear.
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7.1.3.17   Editing Parts - Costing
This option does the costing evaluation of the target parts.

1. Select the part(s).

2. Right mouse click over the part in the Parts toolbar.

3. Select Costing from the context menu.
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4. The dialog part assessment will appear. More information on the options available could be found
on the Parts - Costing section.
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7.1.3.18   Editing Parts - Properties
How to access parts properties. 

1. Select the part(s). Several parts could be selected by using the CTRL button while clicking. This
enables to set common properties to the selection.

2. Press the right mouse button while the cursor is over the part(s) in the Parts library.

3. Select Properties option.

4. Change or add new properties.
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7.1.3.18.1  Parts Properties - Properties 

Use this option to edit the part properties.

Name - Select the part name from the drop down list.

Group - Select group from the drop down list.

Quantity - Number of parts in the project.
Quantity (symmetric) - Number of parts symmetric in the project. 

Symmetric - If ON, the part needs to be cut twice (once mirrored)

Color - Select the part color.

Angle - Insert the start position angle of a part. 

Rotation angles for auto nesting - After inserting the Angle and Range, click "+" button, to add the
new angle range.

To delete an angle range, select it and press "-" button. 

Side - Select the side, between Left or right.

Synchronize with 3D system - If ON, the part will be synchronized with 3D system.
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Variant - Select the part variant

Size rule - Sets how is the scaling of the selected variant.

Exclude - The variant is excluded, i.e, will not be exported. 

All sizes - Normal scaling made to all sizes. 

Size range - Define the size range where the normal scaling made. Outside this range the
variant is excluded. 

Not graded size - The normal scaling will not be applied to this variant. The geometry will
be exported without any changes and with the size defined in the edit box.

Post processing - Allow to filter (remove excessive points) from the outside border, holes or
internal lines. 

Part Contents - Select or deselect the content parts options.

Remove lines outside border - When the part is generated (to send for cut or PDM) all the
lines outside the border will be excluded. 

Remove lines inside holes - When the part is generated (to send for cut or PDM) all the
lines inside the holes will be excluded. 

Trim line groups - For line groups (ex. markers), this option controls if the markers is cut
or deleted when is intersecting the border.

Remove holes outside border - The holes contained outside the part border will not be
exported. 

Group Grading - apply a specific group grading to part. In this case, for the sizes between 32 and
34 use the 34 grade and for sizes between 35 and 37 use the 37 grade. When cutting this part only
sizes 34 and 37 will be sent to the cutter/plotter.
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Full part scaling - Used when a global scale factor is applied to the part, after being scaled by all
the other grading rules.

Apply grading rules - Check/Uncheck to apply grading rules. 

Stencils margin - Allows to control the stencils margins (mm), when cutting the part. 

7.1.3.18.2  Parts Properties - Assessment

The parts assessment allows to have real time consumptions.

Method: Several interlock costing techniques can be used;

There are several methods:

Parts Margin: Adds a margin in mm between parts;

Parts Area: The parts area;
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Parts: The number of parts;

Result: Consumption area for the specified pattern.

Parts Margin: Adds a margin in mm between parts;

Result: Consumption area for the specified pattern.

Efficiency: Measure of efficiency, defined as material area being cut versus raw material area;

7.1.3.18.2.1  Method - Convex Hull

This is a nesting interlock technique called Convex Hull.

It uses the tightest bounding convex polygon (Convex Hull) of the part or part group and evaluates the
resulting area.

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 

7.1.3.18.2.2  Method - Parallelogram

This is a nesting interlock technique called Parallelogram. 

It uses the central point of the part group and packs, without any rotation, the group based on a
parallelogram that is the minimum parallelogram with the shortest height (distance in Y).

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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7.1.3.18.2.3  Method - Inverse Parallelogram

This is a nesting interlock technique called Inverse Parallelogram.

It uses the central point of the part group and packs, without any rotation, the group based on a
parallelogram that is the minimum parallelogram with the shortest height (distance in Y).

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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7.1.3.18.2.4  Method - Bounding box

This is a nesting interlock technique called Bounding Box.

It uses the tightest bounding box of the part group and evaluates the resulting area.

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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7.1.3.18.2.5  Method - Linear

This is a nesting interlock technique called Linear. This is used for linear raw materials automatically
fed from a roll.

It uses the minimum vertical linear strip that fully contains part group and evaluates the resulting
area.

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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7.1.3.18.2.6  Method - Circle

This is a nesting interlock technique called Circle.

It uses a calculated edge of the part group and evaluates, using a circle with a specific radius
traveling over that edge, the boolean union of all those circles.

After choosing the this technique enter the radius

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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7.1.3.18.2.7  Method - Grid

This is a nesting interlock technique called Grid. The system activate the grid over parts.

The operator add the grid value.

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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7.1.3.18.2.8  Method - Synthetic

This is a nesting interlock technique called Synthetic. This is used for synthetic materials available in
rectangular formats.

First the measures of the material should be defined.

The result will be as displayed in the Part assessment panel tab, with the following result metrics: 
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7.1.3.19   Editing Parts - Parts Bar
For a better user experience, a parts bar is available on the lower end of MindCAD 2D Design &
Engineering interface layout. This bar has thumbnails of the parts.

Besides the graphical representation of the part, containing outer boundary and all the elements that
could be included on a part (markers, notches to name a few), there are auxiliary symbols appearing
on the top right corner of the thumbnail.

This symbol means this part is not symmetrical (could be defined in properties).

This symbol means this part has more than one part per foot (could be defined in properties).
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This symbol means this part has an associated group grading (could be defined in properties).

This symbol means this part has variants (could be defined in properties)

This symbol shows the part orientation.

When we hover the cursor on the part, a quick properties window appears.

This button allows filtering parts by material.

This button allows sorting part by alphabetic order.

This button allows hiding empty part thumbnails.

7.2  Parts - Create Hole
This menu lets you to choose between create a hole by contour or by on click.
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7.2.1  Parts - Create Hole - By Contour

This option lets you apply holes to parts. This is the same as clicking the Create Hole   button

in the Parts toolbar.

Treatments can be applied to holes.

To create a hole,

1. Select the part.

2. Select Create Hole from the Parts toolbar

3. Start defining the boundary of the hole. 

4. Define the rest of the boundary of the hole going in one direction.
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5. Click the right mouse button to display the following menu.

6. Select Finish to complete the part. The part can also be finished by pressing the Enter key or
clicking the middle mouse button.

The part will be drawn with the hole.

Use the Finish (and insert reflection) option to put the hole in the reflected part of a folded part.

To delete a hole,

1. Move the cursor over the hole to be deleted. A circular cursor will be displayed
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2. Press the left mouse button to select the hole.

3. Press the Delete key to delete the hole.

7.2.2  Parts - Create Hole - By One Click
1. Select By One Click from Create Hole in the Parts menu.

2. Position the mouse cursor in the middle of the lines that will compose the hole.

3. When the cursor is the right position do a click with the left button, the hole will be created.

7.3  Parts - Create Quality Area
This option lets you create quality areas within parts to aid in the costing process.

1. Select the part to have a quality area applied

2. Select Create Quality Area from the Parts menu  .
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3. Create an area, using the method used to create a hole.

4. When the circular cursor is displayed, select the quality area.

5. Use the Tool Options toolbar to set the quality value.

The quality areas color depends in the quality value. 

7.4  Parts - Add Lines
This option lets you add lines to completed parts.
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7.4.1  Parts - Add Lines - Add Lines
This is the option to add lines to completed parts, if you use this option on unfolded parts, lines will
be added to both sides of the part. Lines added to parts will be drawn on the finished (cut) part.

This is the same as clicking the Add Lines  button in the Parts toolbar  

1. Select the Part to have lines added.

2. Select Add Lines from the Add Lines options of the Parts menu, select Add Lines from the
parts tool bar or press F4.

3. After selecting the required lines, do a right click and select finish from the contextual menu or
press Enter.
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7.4.2  Parts - Add Lines - Add Lines to One Side

This option adds lines, in their original position, to completed mirrored parts.

To add lines to one side of the part,

1. Select the Part to add the Line.

2. Select the Line to be added. 

3. Select Add Line to one side from the Add Lines options of the Parts menu.

4. The line will be added to the part. 
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7.4.3  Parts - Add Lines - Add Lines only to Reflection

This option adds lines in their mirrored position, to completed mirrored parts.

To add lines only to the reflection,

1. Select the Part to add the Line.

2. Select the Line/Stencil to be added. 
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3. Select Add Lines only to reflection from the Add Lines options of the Parts menu.

4. The line will be added to the part. 

7.4.4  Parts - Add Lines - Add Lines on both Sides

This option adds lines to both sides of completed mirrored parts.

To add lines to both sides,

1. Select the Part to add the Line.
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2. Select the Line to be added. 

3. Select Add Lines on both sides from the Add Lines options of the Parts menu.

4. The lines will be added to the part. 

7.5  Parts - Add Cut
This option lets you add lines to completed parts. The lines that are added will be cut when sent to
the cutting table.
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7.5.1  Parts - Add Cut - Add Cut
This option allows choosing where to add the cut.

1. Select the line to be added to the part.

2. Select Add Cut from the Add Cut options of the Parts menu.

3. Select the lines to add the cuts by doing a left mouse click over the shown lines.
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4. To finish the process press the middle mouse button or CTRL key.

5. To edit the selected cut, do the same process and deselect the lines.
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7.5.2  Parts - Add Cut - Add Cut to One Side
This option adds cuts in their original position, to completed mirrored parts.

1. Select one or more parts to have cuts added.

2. Select one or more lines to be added

3. Select Add Cut to One Side from the Add Cut options of the Parts menu.
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The part will have the cut added

7.5.3  Parts - Add Cut - Add Cut only to Reflection
This option adds cuts in their mirrored position, to completed mirrored parts.

1. Select one or more parts to have cuts added.

2. Select one or more lines to be added
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3. Select Add Cut only to Reflection from the Add Cut options of the Parts menu.

The part will have the cuts added
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7.5.4  Parts - Add Cut - Add Cut on both Sides
This option adds cuts to both sides of completed mirrored parts.

1. Select one or more parts to have cuts added.

2. Select one or more lines to be added

3. Select Add Cut on both Sides from the Add Cut options of the Parts menu.

The part will have the cuts added
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7.6  Parts - Add Stencil
This option allows to add lines, text and images to parts. The added elements keep is
characteristics (color, thickness, style, etc) when exported to Cut, using the Printer exporter.

Allowing these elements to be sent directly to the laser machine and designed within the part to cut.

This tool was made for Laser engraving, allowing to print images, text and lines with different color
intensity. 

 

1. Select the Part to add the Stencils.

2. Select Add Stencil from the Add Stencil options of the Parts menu, or press F4.

3. With the left mouse button click over the lines, images or text to add.
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4. When items will be highlighted when selected. 

5. To finish do a right click and select Finish from the contextual menu, or press Enter. 

For images, the machine driver will automatically apply color intensity, lighter colors will by applied
less intensity, darker colors will by applied more intensity.

For Lines and Text, its possible to configure the intensity and machine velocity for each color. The
intensity can also be configured by material type. 

Simulating the Cut in MindCAD2D its possible to check the elements properties that are kept for
each exporter. 

Using the printer exporter:
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7.6.1  Parts - Add Stencil - Add Stencil
This option allows to add or remove lines/stencils through an interactive tool. 

1. Select the Part to add the Stencil/Line.

2. Select Add Stencil from the Add Stencil options of the Parts menu.
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3. After selecting the required lines/stencils, do a right click and select finish from the contextual
menu.

7.6.2  Parts - Add Stencil - To One Side
This option allows to add lines/stencils to one side. 

1. Select the Part to add the Stencil/Line.

2. Select the Line/Stencil to be added. 
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3. Select Add Stencil to one side from the Add Stencil options of the Parts menu.

4. The stencil/line will be added to the part. 

7.6.3  Parts - Add Stencil - Only to Reflection
This option allows to add lines/stencils only on reflection. 

1. Select the Part to add the Stencil/Line.

2. Select the Line/Stencil to be added. 

3. Select Add Stencil only to reflection from the Add Stencil options of the Parts menu.

4. The stencil/line will be added to the part. 
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7.6.4  Parts - Add Stencil - On both Sides
This option allows to add lines/stencils on both sides. 

1. Select the Part to add the Stencil/Line.

2. Select the Line/Stencil to be added. 

3. Select Add Stencil on both sides from the Add Stencil options of the Parts menu.

4. The stencil/line will be added to the part. 
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7.7  Parts - Add Modifier
This option lets you add modifier to completed parts. 

This tool covers the guided deformation of a part through a master line and parameters. On a real
modelling scenario, this will avoid the need to make manual cutting of the original part, to emulate
the stretching imposed by the wrinkling effect. This provided an integrated solution where this kind of
deformation is modelled before the piece being cut, not after.

Several options are available to add this kind of effect (One side, Reflection and Both sides).
Please refer to the following sections.

Add modifier to one side

Add modifier only reflection

Add modifier on both sides

7.7.1  Parts - Add Modifier - To one side
This option add modifiers to one side.

1. Select one part to add the modifier.

2. Select one or more lines to be added
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3. Select Add on one Side from the Add Modifier options of the Parts menu.

4. Set the modifier values.

Crease
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Mode Select the mode between Rotate or Offset.

Amount
(mm):

This value controls the amount of added material for the crease mode. 

Smooth This value controls the smoothness of the change.

Central
markers

Add central markers automatically using the modifier line.

Margin
markers

Add margin markers automatically using the modifier line.

Stretch

Percentage
(%)

Absolute
(mm)

Select how to input the values between Percentage or Absolute.

This values control the amount of added material along the selected edge, that
should exist to compensate the wrinkle effect.

Start decay
(mm)

This value controls the beginning of the blending region.

End decay
(mm)

This value controls the end of the blending region.

Decay
function

Select the decay function between Linear, Sharp or Smooth.

Direction Select the stretch direction between Forward, Back or Both. 

Middle point
(%)

Define in which point of the line the modifier should be applied. Ex: applied from the
line beginning (middle point = 0%), from the line middle ( middle point = 50%) or the
line ending (middle point = 100%).

Markers Add markers automatically using the modifier line. 

Invert
direction

 Enable/disable the invert direction option. If active inverts the line direction, so the
modifier is applied backwards. 

7.7.2  Parts - Add Modifier - Only to reflection
This option add modifiers only to reflection.

1. Select one part to add the modifier.
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2. Select one or more lines to be added.

3. Select Add only to reflection from the Add Stretch options of the Parts menu.

4. Set the modifier values.
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Crease

Mode Select the mode between Rotate or Offset.

Amount
(mm):

This value controls the amount of added material for the crease mode. 

Smooth This value controls the smoothness of the change.

Central
markers

Add central markers automatically using the modifier line.

Margin
markers

Add margin markers automatically using the modifier line.

Stretch

Percentage
(%)

Absolute
(mm)

Select how to input the values between Percentage or Absolute.

This values control the amount of added material along the selected edge, that
should exist to compensate the wrinkle effect.

Start decay
(mm)

This value controls the beginning of the blending region.

End decay
(mm)

This value controls the end of the blending region.

Decay
function

Select the decay function between Linear, Sharp or Smooth.

Direction Select the stretch direction between Forward, Back or Both. 

Middle pointDefine in which point of the line the modifier should be applied. Ex: applied from the
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(%) line beginning (middle point = 0%), from the line middle ( middle point = 50%) or the
line ending (middle point = 100%).

Markers Add markers automatically using the modifier line.

Invert
direction

 Enable/disable the invert direction option. 

Applying a Crease modifier:

Mode: Rotation Mode: Offset

Applying a Stretch modifier:

7.7.3  Parts - Add Modifier - On both Sides
This option add modifiers to both sides.

1. Select one part to add the modifier.
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2. Select one or more lines to be added.

3. Select Add on both Sides from the Add Stretch options of the Parts menu.

4. Set the modifier values.
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Crease

Mode Select the mode between Rotate or Offset.

Amount
(mm):

This value controls the amount of added material for the crease mode. 

Smooth This value controls the smoothness of the change.

Central
markers

Add central markers automatically using the modifier line.

Margin
markers

Add margin markers automatically using the modifier line.

Stretch

Percentage
(%)

Absolute
(mm)

Select how to input the values between Percentage or Absolute.

This values control the amount of added material along the selected edge, that
should exist to compensate the wrinkle effect.

Start decay
(mm)

This value controls the beginning of the blending region.

End decay
(mm)

This value controls the end of the blending region.

Decay
function

Select the decay function between Linear, Sharp or Smooth.
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Direction Select the stretch direction between Forward, Back or Both. 

Middle point
(%)

Define in which point of the line the modifier should be applied. Ex: applied from the
line beginning (middle point = 0%), from the line middle ( middle point = 50%) or the
line ending (middle point = 100%).

Markers Add markers automatically using the modifier line.

Invert
direction

 Enable/disable the invert direction option. 

Applying a Crease modifier:

Mode: Offset

Applying a Stretch modifier:
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7.8  Parts - Remove - Lines
This option removes lines that have been added to parts. This is the same as clicking the Remove

lines  button in the Parts toolbar

1. Select the one or more parts to have the line removed from

2. Select one or more lines to be removed

3. Select Lines from the Remove options of the Parts menu.

 

The lines will be removed from the part
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7.9  Parts - Insert Lines on Border
This option lets you insert lines into an already finished part.

1. Select the part to be edited.

2. Select Insert Lines on Border from the Parts menu.
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3. Select the line that comes before the line(s) to be inserted

4. Select one or more lines to be inserted

5. Select the line that comes after the line(s) to be inserted
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6. Click the right mouse button to display the popup menu.

7. Select Finish to complete the part. The part can also be finished by pressing the Enter key or
clicking the middle mouse button.

The part will be highlighted.

7.10  Parts - Replace Lines
Use this to replace lines in your parts. It allows you to change one line for another on all selected
parts.
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7.10.1  Parts - Replace Lines - Replace Lines
This option lets you replace one line with another on completed parts.

1. Select the line to be replaced (the original line).

2. Select Replace Lines from the Replace Lines options of the Parts menu.

3. Select the replacement line (the new line).

The part will be drawn with the new line as part of the boundary.
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7.10.2  Parts - Replace Lines - Replace Lines on Reflection
This option lets you replace one line with another, on the reflected side of parts that have been
mirrored/reflected.

1. Select the line to be replaced (the original line).

2. Select Replace Lines on Reflection from the Replace Lines options of the Parts menu.

3. Select the replacement line (the new line).
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The part will be drawn with the new line as part of the boundary.

7.10.3  Parts - Replace Lines - Replace Lines/Reflection
This option lets you replace one line with another, on both sides of the parts that have been mirrored/
reflected

1. Select the line to be replaced (the original line).
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2. Select Replace Lines/Reflection from the Replace Lines options of the Parts menu.

3. Select the replacement line (the new line).

The part will be drawn with the new line as part of the boundary.
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7.11  Parts - Delete Part
This option deletes the current part(s). This is the same as selecting the part from the Parts/Library
Bar, do a right click over it and select Delete.

7.12  Parts - Delete All Parts
This option deletes all parts.
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7.13  Parts - Auto Add Lines on Creation
This option adds lines on creation of the parts.

Off Will disable auto insertion of lines

On normal side Add in normal side

On reflected side Add in reflected side

On both sides Add on both sides

1.  Active the option on normal side;

2. Now if you create punches, notches, markers or corners they will be added to the select part
automatically (if they are located in the area of the part)
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7.14  Parts - Costing
This option makes shape consumption assessment part by part.

Several display options could be configured to better evaluate the consumption like material, part,
size, grouping and other like technique will control the evaluation costing algorithms.

Material - select which material already assigned to parts will be displayed.

Size - select which sizes of parts will be displayed.
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Part - select the part that will be displayed.

Group by - select how to group the results

Technique - select the costing technique.

Group Common Sizes - Select this option to group common sizes.

Options - Select this option to configure the costing options.

Report - print a report
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PDF - Save a report in PDF format.

CVS - Save a report in CVS format.
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7.14.1  Parts - Costing - Options
This option allows to adding costing options.

1. Create new Pricing settings

2. Insert the name and the other costing properties.
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3. In the Punches Cost it's possible to assign them to specific properties.

4. To create a new property  go to Preferences, Default Properties tab.

5. To assign the punch to the property, select the punches distribution and go to the preferences in
the tool options box.

6. In the costing option, the name that is inserted in the Punches #1 property must match with the
name given to the property assigned to the punches distribution.

The punch cost 1# represents the cost of the punches that have that property assigned. 

7. Press Ok to finish the Costing Option.



Part

VIII
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8  Grading Overview
This menu lets you carry out all operations to grade and group grade a shell.

8.1  Grading - Basics Steps for Grading
To quickly start grading for your shell some basic steps are necessary:

1. Insert the Center Point .
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2. Input the measures of the last . 

3. Select Grading Table  .

4. A grading axis is created automatically (by default is horizontal) and a dialog to establish the
grading table rules is opened. When finished configuring the rules, press OK.
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8.2  Grading - Define Points
Use these options to define the points used to measure the length and width of the shell. The values
calculated from these points are used as the length and width in the grading table.

8.2.1  Grading - Define Points - All
Use this option to define the four points used to measure the length and width of the shell.

This is the same as clicking the Define Points  button in the Grading toolbar.

After selecting this option the cursor is displayed as a large dotted cross hair. The point to be placed
is positioned on the cross hair and is placed by clicking the left mouse button. As each point is
placed the next point to be placed is displayed at the cross hair.
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8.2.2  Grading - Define Points - Back
Use this option to place or move only the back point.

8.2.3  Grading - Define Points - Front
Use this option to place or move only the front point.

8.2.4  Grading - Define Points - Centre

Use this option to place or move only the centre point.

8.2.5  Grading - Define Points - Girth
Use this option to place or move only the girth point.
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8.3  Grading - Last Measures

Use this option to display the Length and Width measurements used for grading. 

It is possible to type in values if required.

8.4  Grading - Select Main Grading Axis
Use this option to set a main grading axis.

§ If the shell has been drawn, digitised or imported from non MindCAD software, one axis must be
set as the main grading axis.

.1.Select the axis required and then use this option.

.2.Select Select Main Grading Axis from the Grading menu.  

§ If the shell has been exported from 3D Design & Engineering, the axis is already set, and this
option does not need to be used.

8.5  Grading - Grading Table
Use this option to set up the size ranges to be graded and increments between sizes.

This is the same as clicking the Grading Table  button in the Grading toolbar or pressing Ctrl
+Shift+G.

To create a grading table,

1. select Grading Table from Grading menu. The Grading Table dialogue box is displayed.

2. use the dialogue box to set up the size ranges and increments between the sizes (Main
grading).
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Lock - When this option is active, it's possible to change the values but when the Ok button is
pressed the below message will appear.

Type - Select the type of grading, (English or Continental) from the drop down list.

Model - Set the model size.

First - Set the first (smallest) size you want to grade. You can select this from the drop down list or
enter a value.

Last - Set the last (largest) size you want to grade. You can select this from the drop down list or
enter a value.

Step - Set the step between sizes using the drop down list. Available options are 1, ½, 1/3, ¼

Increments - When you select a Type (English or Continental) the standard grading increments are
applied for that grade type. If required, these can be edited in the increment boxes.

+/- - Add/remove grading sections (these sections are created when there are sizes ranges with
different increments) 

 

Advanced - switch to expert view of the grading table specification.

Library - allows to save/load grading specifications on a library. While browsing for a specific grading
specification, there is the possibility to filter by grading type and base number:
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Filters - filters the tree list using Grading type or Base number

Load - loads the grading specification. Extra control is possible by checking the following fields:
Read Table, Read Base, Read Sizes)

Save - Saves a grading specification

While in the expert view additional fields are available:

Cascade update - If ON, table values are updated automatically after operator input.

For each size, the operator can make individual changes of the following parameters:

Length Dif. - length increment between sizes

Lengths - last length for each size

Width Dif. - width increment between sizes

Widths - last width for each size

Alias - use another size grading specification (ie. size 4 will have the same
measures of the 4 1/2)

Reset - reset of increment values to the default increment grading value.

Simple - switch to simplified view of the grading table specification
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3. Click OK to confirm or Cancel to discard changes.

4. If the values of the advanced table are change  

5. When the values from the Detailed grading table are changed by the user, the Main grading
table will change to yellow, as a warning.  

8.5.1  Grading - Grading Table - Sub-Grading
Use this option to restrict the amount of grade on a line(s) . 

1. create the axis for the sub-grading. 
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2. select the lines to be sub-graded.

3. if the sub-grading is to be applied only to a section of the lines then select the affected area by
doing a net selection while pressing Shift.
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4. open the grading table specification and press Advanced for the expert view.

5. create the sub-grading pressing New  button. Rename the sub-grading to a
meaningful name. Under the created node, information about the lines to be affected (ie. Line 371,
Line 373 and Axis). The plus button allows to add lines to the selected sub-grading.
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6. control sub-grading increments on X and Y. If there is the need not to scale on the direction of the
sub-grading axis, the zero value should be used for the X increment. Likewise for a direction
perpendicular to the sub-grading axis, the zero value should be used for the Y increment. Control of
increments size by size is possible using the Length Dif. and Width Dif. rows on the grading table.
To finalize, press OK.
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7. lines being affected by a sub-grading will turn into a ruby colour, the constrained control points
turn into red and the unrestricted control points into blue. 

8. use Show Grading button to visualize the sub-grading affecting the lines and its related parts.

9. if there is the need to smooth the end result, please refer to Grading Connection
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10. to remove a sub-grading or an associated line, select it and then press the Delete key. On
confirmation  dialog answer Yes.

8.5.2  Grading - Grading Table - Fittings
Use this option to restrict the amount of grade on a line. This is typically used on child footwear.

1. select the lines to be affected by the fitting.
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2. if the fitting is to be applied only to a section of the lines then select the affected area by doing a
net selection while pressing Shift.

3. open the grading table specification, press Advanced for the expert view and select Fittings tab.

4. create the fitting pressing New  button. Rename the fitting to a meaningful
name. Under the created node, information about the lines to be affected (ie. Line 371, Line 373 and
Axis). The plus button allows to add lines to the selected fitting. Select a Size Range (ie. Min.: A,
Base: B and Max.: C)

5. control fitting increments on X and Y. If there is the need not to scale on the direction of the
grading axis, the zero value should be used for the X increment. Likewise for a direction
perpendicular to the grading axis, the zero value should be used for the Y increment. Control of
increments size by size is possible using the Length Dif. and Width Dif. fields. To finalize, press
OK.
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6. lines being affected by the fitting will turn into a ruby colour, the constrained control points will be
displayed inside red diamond shapes and the unrestricted control points into blue. 

8. use Show Grading button to visualize the fitting affecting the lines and its related parts.
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9. if there is the need to smooth the end result, please refer to Fittings Grading Connection

10.  to remove a fitting or an associated line, select it and then press the Delete key. On
confirmation  dialog answer Yes.

8.6  Grading - Group Grade
Use this option to apply group grading to lines or points within lines.

This is the same as clicking the Group Grading  button in the Grading toolbar.

1. Select line(s) for group grading

2. Select Group Grade from the Grading menu. A dialogue box is displayed

3. Select group required.

4. Select Apply. The lines will be highlighted to confirm selection

5. Press the middle button to finish.
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8.6.1  Applying options to points within lines (blended grading)._2

1. select line(s) for group grading

2. select Group Grade from the Grading menu. A dialogue box is displayed

3. select group required.

4. select points on the lines.

5. select Apply

If only one group is applied to a point on a line, the whole line will be graded to that rule, so a further
grade must be applied to the same line
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6. select another point(s) on the line and apply another grade.

7. press the middle button to finish.

8.6.2  View Group Grade
Use this option to visualize the group grades applied to the model

1. select Group Grade from the Grading menu. A dialogue box is displayed

2. visualization of the existing group grades and corresponding associated lines.
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8.7  Grading - Create Grading Centre
Use this option to create grading centres, on selecting this option a menu is displayed.

This is the same as clicking the Create Grading Centre  button in the Grading toolbar.

1. select Create Grading Centre from the Grading menu. The Tool Options toolbar displays
appropriate options.

2. type in a Name for the grading centre.

3. Move the cross hairs to the position required for the grading centre and press the left mouse
button.
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4. Click the middle mouse button to finish.

Tips:

1. Grading Centres can be group graded from other grading centres using the two buttons in the
group creation menu.

2. If Grading Centres are selected, the tool options menu will be displayed for editing and the
Grading Centre can be moved.

3 Intersecting Grading Centres will always be placed at the intersections of the lines even if the lines
have different grade rules.

8.7.1  Creating a grading centre on the intersection of two lines.
1. select Create Grading Centre from the Grading menu. The Tool Options toolbar displays

appropriate options.

2. type in a Name for the grading centre.
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3. select Intersection

4. the cursor will be displayed  select the two lines that define the intersection.

5. press the middle mouse button to complete the command.



485Grading Overview

© 2016 M ind - Software Multimedia e Indus tr ial , SA

8.8  Grading - Assign Grading Centre
Use this option to assign a grading centre to a line.

This is the same as clicking the Assign Grading Centre  button in the Grading toolbar.

To assign a grading centre,

1. select the lines you want to assign to a grading centre.

2. select Assign Grading Centre from the Grading menu. A dialogue box will be displayed with the
grading centres available

3. select the required grading centre and click OK

8.9  Grading - Apply Restriction

Use this option to restrict the amount of grade on a line   .

If lines are 'linked' the amount of grade between the lines will always be constant. If lines are not
'linked' and parallel, when the lines are graded the distance between the lines will grade. This applies
to parallel lines or any other implicit distance relation the operator wants to enforce .

To avoid this general grading behaviour, use this option. Detailed explanation of available options is
done just ahead.

8.9.1  Grading - Apply Parallel Restriction
Use this option to restrict the amount of grade on a line.

This is the same as clicking the Restriction  button in the Grading toolbar.

To apply parallel restriction,
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1. select the line to have the restriction applied.

2. select Apply Restriction from the Grading menu. On the Tool Options select Parallel option.

3. type in the value or using the double circle red handle just simply drag to the desired position. A
measure helper will be displayed while dragging.
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4. if the restriction is constant do not add any further values. 

If the restriction is different at a different point, select another double circle red handle and apply or
drag to a new value.

5. to change side or to remove restrictions the following buttons are available

Highlighted - Switch side / Remove for the selected handle

All - Switch side / Remove for all the handles

6. click the middle mouse button to finish. The line being constrained turn into red.
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8.9.2  Grading - Apply Directional Restriction
Use this option to restrict the grade between lines of different geometry.

This is the same as clicking the Restriction    button in the Grading toolbar.

When graded, the distance between the lines will remain constant at the points where the restriction
is applied even though the length of the line changes.

To apply directional restriction,

1. select the line to have the restriction applied.
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2. select Apply Restriction from the Grading menu. On the Tool Options select Directional
option
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3. using the left mouse button drag the restriction handle to the required point or set the Distance
value.

4. drag the other shown restrictions to their required points. Please note, the operator could only set 
Distance values handle by handle and let the system decide the best direction for a smooth
result.
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5. to change side or to remove restrictions the following buttons are available

Highlighted - Switch side / Remove for the selected handle

All - Switch side / Remove for all the handles

6. press the middle mouse button to complete the command.

Only when in directional restriction, the distance values could be configured based on grading
adjustment on XX and YY. The following options are only available when Directional is selected and
if an already configured main grading with at least two sizes exists.

Additional to the previous steps, for each handle selected
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7. Select Adjust grading on XX. Input the value in mm to add or remove for each measure unit and
axis direction.

8. Finalize pressing OK.

8.10  Grading - Show Grading
Use this option to 'knock' your graded sizes for checking.

This is the same as clicking the Show Grading  button in the Grading toolbar.

1. select the lines to be knocked. If none are selected all lines will be knocked. Alternatively, select
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one or more parts.

2. select Show Grading from the Grading Menu. Your graded sizes will be displayed

3. click the left mouse button to knock to any position

4. hold the left mouse down and drag he mouse with the left mouse button held down to see the
knocking done in real time.

To select specific sizes within the graded range,

1. use the Tool Options toolbar to select specific sizes within the graded range. Use the Ctrl key to
add sizes.
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2. click the middle mouse button to finish.

8.11  Grading - Advanced
Use this menu to access the following options:
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8.11.1  Grading - Advanced - Grading Shell
Use this option to create a new model size shell.

1. When the option has been selected a warning message is displayed

2. Select Yes to continue. A second message is displayed

3. Use the drop down list to select the size of the new model and OK

As this is a new model size, all grading options have to be used again.

8.11.2  Grading - Advanced - Grading Connection
The purpose of this tool is to provide smooth line connection on sub-gradings.

When a sub-grading restriction is applied to a certain area (the red handles) the other have the
normal grading rules (the blue handles). 
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Generally, this leads to some imperfections on the transition area. This is showed when knocking
the parts as depicted below.

To avoid this undesirable effect do the following:
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1. select lines with the sub-grading; select the handles of the transition area (include red and blue
handles) by doing a net selection while pressing Shift 

2. select Grading Connection from the Advanced options on the Grading menu. The smoothing
connection handles will turn into a light blue.
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Now, when doing the knocking of the parts the imperfections disappear.

8.11.3  Grading - Advanced - Fittings Grading Connection
The purpose of this tool is to provide smooth line connection on fittings.

When a fitting restriction is applied to a certain area (the blue handles inside red diamond shapes)
the other have the normal grading rules (the blue handles). 

Generally, this leads to some imperfections on the transition area. This is showed when knocking
the parts as depicted below.
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To avoid this undesirable effect do the following:

1. select lines with the fitting applied. Select the handles of the transition area (include diamond
shaped handles and blue handles) by doing a net selection while pressing Shift 

2. select Fittings Grading Connection from the Advanced options on the Grading menu. The
smoothing connection handles will appear inside blue diamond shapes.

Now, when doing the knocking of the parts the imperfections disappear.
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8.11.4  Grading - Advanced - Remove Grading
Use this option to remove grading from a shell.

1. when the option has been selected a warning message is displayed

2. select Yes. A further menu is displayed

3. if you want to grade the shell again and are happy with the last measures click No. If you want to
measure the last again click Yes

8.11.5  Grading - Advanced - Axis Grading Mode
Use this option to maintain the angle of a grading axis.

1. select the axis

2. select Axis Grading Mode from the Advanced options on the Grading menu

A dialogue box is displayed

3. click OK

The angle of the axis will be maintained, the first point of the axis will grade normally and the angle
will be held constant from that graded position.
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9  Window Overview
This lets you control the position and the way your windows are arranged on the screen.

9.1  Window - Cascade
This option lets you display your windows in a cascade.
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9.2  Window - Side by Side
This option lets you display your windows side by side.

9.3  Window - List
Select the name of a current window to make it active.
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10  Applications Overview
This lets you switch to other MindCAD applications.

 

10.1  Applications - 3D Design & Engineering
This option lets you switch to the 3D Design & Engineering package.

3D Design & Engineering lets you

create your 3D designs

create 3D parts

create and import soles

visualize your finished shoe.

10.2  Applications - Last Design & Engineering
This option lets you switch to the Last Design & Engineering package.

Last Design & Engineering lets you create or import lasts

The lasts can then be edited and the surfaces flattened for use in 3D Design & Engineering.
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11  Help Overview
This lets you launch the help system, open the Mind web site and display the version number of the
current software.

11.1  Help - Help Topics
This option lets you launch the help system.

11.2  Help - Mind on the Web
This option lets you open the Mind website.
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11.3  Help - About MindCAD 2D Design & Engineering
This option displays a dialogue box containing the version number.
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